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Vision of the Department
Department of mechanical engineering is committed to prepare graduates, post graduates and
research scholars by providing them the best outcome based teaching-learning experience and
scholarship enriched with professional ethics.

Mission of the Department
M-1: Prepare globally acceptable graduates, post graduates and research scholars for their lifelong
learning in Mechanical Engineering, Maintenance Engineering and Engineering Management.
M-2: Develop futuristic perspective in Research towards Science, Mechanical Engineering Maintenance
Engineering and Engineering Management.
M-3: Establish collaborations with Industrial and Research organizations to form strategic and
meaningful partnerships.

CAD/CAM LABORATORY
Subject Code

: ME57L

No. of Credits

: 0- 0 – 1.5

No. of Lecture Hours / Week

: 04

Exam Hours

: 3

Total No. of Lecture Hours

: 48

Exam Marks

: 100

COURSE OBJECTIVES:



To impart the students with necessary computer aided modeling skills using standard CAD
packages.
To expose the students to the techniques of CNC programming and cutting tool path generation
through CNC simulation software by using G-Codes and M-codes and writing part program for
simple machine parts.

COURSE CONTENT
PART – A
COMPUTER AIDED DESIGN
Study of Solid modeling Package (UG-NX). Solid Modeling of simple machine parts and
assembly.
10 Exercises
PART – B

20 Hours

COMPUTER AIDED MANUFACTURING
Writing of manual part programming using ISO codes for turning and milling operations. Use of
tool radius compensation and canned cycles. Check the program for syntax errors, lists errors
and locations, show the tool path through graphical simulation using EXSL-WIN or other CAM
Packages.
Modelling of simple machine parts (Turning and Milling) and generating machine codes using
standard NX CAM or other CAM Packages
28 Hours
COURSE OUTCOMES
Upon completion of the course, students shall be able to:
CO1 : Modeling of simple machine parts and assemblies from the part drawings using standard
CAD packages.
CO2 : Generate CNC Turning and Milling codes for different operations using standard CAM
packages. Write manual part programming using ISO codes for turning and milling
operations

BRIEF HISTORY OF CAD/CAM DEVELOPMENT
The roots of current CAD/CAM technologies go back to the beginning of civilization when
engineers in ancient Egypt recognized graphics communication. Orthographic projection
practiced today was invented around the 1800’s. The real development of CA D/CAM systems
started in the 1950s. CAD/CA M went through four major phases of development in the last
century. The 1950’s was known as the era of interactive computer graphics. MIT’s Servo
Mechanisms Laboratory demonstrated the concept of numerical control (NC ) on a three-axis
milling machine. Development i n this era was slowed down by the shortcomings of computers
at the time. During the late 1950’s the development of Automatically Programmed Tools (APT)
began and General Motors explored the potential of interactive graphics.
The 1960s was the most critical research period for interactive computer graphics. Ivan
Sutherland developed a sketch pad system, which demonstrated the possibility of creating
drawings and altercations of objects interactively on a cathode ray tube (CRT). The term CAD
started to appear with the word ‘design’ extending beyond basic drafting concepts. General
Motors announced their DAC-1 system and Bell Technologies introduced the GRAPHIC 1
remote display system.
During the 1970’s, the research efforts of the previous decade in computer graphics had begun to
be fruitful, and potential of interactive computer graphics in improving productivity was realized
by industry, government and academia. The 1970’s is characterized as the golden era for
computer drafting and the beginning of ad hoc instrumental design applications. National
Computer Graphics Association (NCGA) was formed and Initial Graphics Exchange
Specification (IGES) was initiated.
In the 1980’s, new theories and algorithms evolved and integration of various elements of design
and manufacturing was developed. The major research and development focus was to expand
CAD/CAM systems beyond three-dimensional geometric designs and provide more engineering
applications.
The present day CAD/CAM development focuses on efficient and fast integration and
automation of various elements of design and manufacturing along with the development of new
algorithms. There are many commercial CAD/CAM packages available for direct usages that are
user-friendly and very proficient.
Below are some of the commercial packages in the present market.
AutoCAD and Mechanical Desktop are some low-end CAD software systems, which are
mainly used for 2D modeling and drawing.

NX, Pro-E, CATIA and I-DEAS are high-end modeling and designing software systems that
are costlier but more powerful. These software systems also have computer aided
manufacturing and engineering analysis capabilities.

ANSYS, ABAQUS, NASTRAN, Fluent and CFX are packages mainly used for analysis of
structures and fluids. Different software are used for different proposes. For example,
Fluent is used for fluids and ANSYS is used for structures.


Alibre and CollabCAD are some of the latest CAD systems that focus on collaborative design,
enabling multiple users of the software to collaborate on computer-aided design over the
Internet.

DEFINITION OF CAD/CAM/CAE
Computer Aided Design – CAD
CAD is technology concerned with using computer systems to assist in the creation,
modification, analysis, and optimization of a design. Any computer program that embodies
computer graphics and an application program facilitating engineering functions in design
process can be classified as CAD software.
The most basic role of CAD is to define the geometry of design – a mechanical part, a
product assembly, an architectural structure, an electronic circuit, a building layout, etc. The
greatest benefits of CAD systems are that they can save considerable time and reduce errors
caused by otherwise having to redefine the geometry of the design from scratch every time it is
needed.
Computer Aided Manufacturing – CAM
CAM technology involves computer systems that plan, manage, and control the
manufacturing operations through computer interface with the plant’s production resources.
One of the most important areas of CAM is numerical control (NC). This is the technique of
using programmed instructions to control a machine tool, which cuts, mills, grinds, punches or
turns raw stock into a finished part. Another significant CAM function is in the programming of
robots. Process planning is also a target of computer automation.
Computer Aided Engineering – CAE
CAE technology uses a computer system to analyze the functions of a CAD-created product,
allowing designers to simulate and study how the product will behave so that the design can be
refined and optimized.
CAE tools are available for a number of different types of analyses. For example, kinematic
analysis programs can be used to determine motion paths and linkage velocities in mechanisms.
Dynamic analysis programs can be used to determine loads and displacements in complex
assemblies such as automobiles. One of the most popular methods of analyses is using a Finite
Element Method (FEM). This approach can be used to determine stress, deformation, heat
transfer, magnetic field distribution, fluid flow, and other continuous field problems that are
often too tough to solve with any other approach.

STARTING NX7 SESSION AND OPENING FILES
Open NX7 Session
From the Windows desktop screen, click on Start → Programs → UGS NX 7.5 → NX 7.5

The main NX7 Screen will open. This is the Gateway for the NX7 software. The NX7 blank
screen looks like the figure shown below. There will be different tips displayed on the screen
about the special features of the current version. The Gateway also has the Standard Toolbar that
will allow you to create a new file or open an existing file. On the left side of the Gateway
screen, there is a Toolbar called as Resource Bar that has menus related to different modules
and the ability to define and change the ‘Role’ of the software, view ‘History’ of the software
use and so on. This will be explained in detail later in this chapter. Let’s begin by learning how
to open a part file in NX7.

To create a new file there are two options. You can click on the ‘New’ tab on top of the screen
or go through the ‘File’ drop-down menu.

Open a New File
On the menu bar found at the top-left of the screen, click FILENEW
This will open a new session, asking for the name and location of the new file to be created as
shown at the bottom left. You need to select the units (inches or millimeters) of the working
environment by clicking on the drop-down menu on the top right corner. The default is
millimeters. However, most of the material in the tutorials is modeled in inches. So always,
be sure to select inches before creating a new .prt file unless otherwise specified. You can also
select the type of the file you want to create – either a part file or an assembly file or sheet-metal
file – by selecting the file type as shown in Templates dialogue box located at the center of the

window. The properties of the selected file are displayed below the Preview on the middle right
corner.
Enter the location of the file and then and click OK

Open a Part File
Click FILE → OPEN
You can also click the Open icon from the Standard toolbar at the top of the screen.
The Open Part File dialog will appear. You can see the preview of the files on the right side of the
window. You can disable the Preview by un-clicking the box in front of the Preview button.

Click CANCEL to exit the window

How to use the constraints tool
Draw the sketch shown below:

Sketch you need to draw
Once the sketch is complete, we will constrain the sketch. It is better to apply
thegeometric constraints before giving the dimensional constraints.
>>> Choose INSERT → CONSTRAINTS or click on the Constraints icon in the side toolbar
You will be able to see all the degrees of freedom on the screen represented by orange arrows.

orange color arrows are the no of DOF to be constrained

We will start by constraining between an entity in the sketch and the datum or fixed reference.
As an example, we will place the center of the arc at the origin. We can use the two default
X and Y axes as a datum reference.
> Select the Y-axis and then the center of the arc, which is marked by the intersection of
the yellow arrows. The center of the arc will be marked by a red asterisk once it has
been selected
> Click the Point on Curve icon

>Repeat the same procedure to place the center of the arc on the X-axis
> Select the two slanted lines and make them equal in length

> Similarly select the two long vertical lines and make them equal in length

Select the bottom two horizontal lines and make them collinear and then click on the same lines
and make them equal in length

If you DO NOT find the two Blue circles (Tangent Constraints) near the semicircle as shown
in the figure, follow the below steps. Otherwise, you can ignore this and skip down to
the dimensional constraints.

>Select the circular arc and one of the two vertical lines connected to its endpoints

> Select the Tangent icon

If the arc and line is already tangent to each other, the icon will be grayed out. If that is the
case click on EDIT → SELECTION →, DESELECT ALL. Repeat the same procedure for the

arc and the other vertical line.

>Select the two vertical lines and make them equal

> Similarly select the two small horizontal lines and make them collinear and equal

>Similarly select the two vertical lines and make them equal

So far, we have created all the geometric constraints. Now we have to create the
dimensional constraints. You will find that as we add on dimensions, the degrees of freedom
represented by the yellow arrows will disappear.

It is always better to apply the geometry constraints first. If there is any conflict between the
dimensional and geometric constraints, those
entities will be highlighted in yellow.
> Choose the Inferred Dimensions icon in the Constraints toolbar
> Add on all the dimensions as shown in the following figure

For example, to create a dimension for the top two corners, you may have to click on the
arrow next to the Inferred Dimensions icon and click on the Horizontal icon. Then click
somewhere near the top of the two diagonal lines to select them. While dimensioning, if you find
the dimensions illegible, but do not worry about editing the dimensions now. Make sure the
small arrows are disappearing as constraints are placed.

All dimensions are given after Geometrical Constraints
Now we will edit all the dimension values one by one. It is highly recommended to start
editing from the biggest dimension first and move to the smaller dimensions.
> Edit the values as shown in the figure below. Double click on each dimension to change
the values to the values as shown in figure below:

Fully Constrained Sketch

> Click on the Finish flag on the top left corner of the screen when you are finished

Primitives
They let you create solid bodies in the
form of generic building shapes.
Primitives include,



Block
Cylinder
Cone
Sphere

Primitives are the primary entities. Hence we will begin with a short description of primitives
and then proceed to modeling various objects.

PRIMITIVES
Primitive features are base features from which many other features can be created. The basic
primitives are blocks, cylinders, cones and spheres. Primitives are non-associative which means
they are not associated to the geometry used to create them. The parameters of these primitive
objects can be changed.
Now let us start modeling of some basic objects.
Model a Block
Create a new file and name it as
Arborpress_plate.prt
Now let us model a plate.
Choose INSERT → DESIGN FEATURE →
BLOCK or click on the Block icon in the
Form Feature Toolbar
The Block window appears. There are three main
things to define a block. They include the Type,
Origin and the Dimensions of the block. To access
the Types scroll the drop-down menu under Type.
There are three ways to create a block primitive.



Origin, Edge Lengths
Height, Two Points
Two Diagonal Points


Make sure the Origin, Edge Lengths method
is selected
Now, we will choose the origin using the Point
Constructor.
Click on the POINT CONSTRUCTOR icon
under the Origin
or
Click on the POINT CONSTRUCTOR icon in the Utility Toolbar as shown in the
following figure.

The Point Constructor box will open. The XC, YC, ZC points should have a default value of 0.

Click OK
The Block window will reappear.
Type the following dimensions in the
window.
Length (XC) = 65 inches
Width (YC) = 85 inches
Height (ZC) = 20 inches
Click OK
If you do not see anything on the screen, right-click and select FIT. You can also press
<Ctrl> + F

Right-click on the screen and click on ORIENT VIEW → TRIMETRIC

You should be able to see the complete plate solid model. Save and close the part file.

Model a Shaft
After modeling a basic block, we will now model a
shaft having two cylinders and one cone joined together.
Create a new file and save it as Impeller_shaft.prt
Choose INSERT → DESIGN FEATURE →
CYLINDER
Similar to the Block there are three things that need to
be defined to create a cylinder, Type, Axis & Origin,
Dimensions.
A Cylinder can be defined by two types which can be
obtained by scrolling the drop-down menu under Type
Axis, Diameter, Height

Arc, Height

Select AXIS, DIAMETER, HEIGHT

Click on the Vector Constructor icon next to Specify
Vector as shown on the second figure on right.

Click on the ZC Axis icon.

Leave the other options as default and click OK


Click on the Point Constructor icon next to
Specify Point to set the origin of the cylinder

Set all the XC, YC, and ZC coordinates to be 0

You can see that the selected point is the origin of WCS
In the next dialog box of the window, type in the
following values as shown in figure
Diameter = 4 inches
Height = 18 inches

Click OK

Click CANCEL on any other windows that appear
Right-click on the screen, choose ORIENT VIEW → ISOMETRIC
You can change the color of the solid body and the background as mentioned in the Chapter
2.3.4. The cylinder will look as shown below.

Now we will create a cone at one end of the cylinder.
Choose INSERT → DESIGN FEATURE → CONE
Similar to Block and Cylinder there are various ways
to create a cone which can be seen by scrolling the
drop-down menu in the Type box.



Diameters, Height
Diameters, Half Angle
Base Diameter, Height, Half Angle
Top Diameter, Height, Half Angle
Two Coaxial Arcs



Select DIAMETERS, HEIGHT

Click on the Vector Constructor icon next to Specify
Vector.

Choose the ZC-Axis icon so the vector is pointing in
the positive Z direction

Click OK

Click on the Point Constructor icon next to Specify Point to set the origin of the cylinder.
The Point Constructor window will appear next.

Choose the Arc/Ellipse/Sphere Center icon on
the dialog box and click on the top circular edge of
the cylinder
OR
For the Base Point coordinates, type in the
following values: XC = 0 YC = 0 ZC = 18
Click OK
In the cone window, type in the following values:
Base diameter = 4 inches
Top Diameter = 6 inches
Height = 10 inches
Click OK
On the Boolean Operation window, choose
UNITE
Now the cone will appear on top of the cylinder.
Click CANCEL on any other windows
Press <Ctrl> + F OR right-click and select FIT
The shaft is as shown on right.
Now we will create one more cylinder on top of the cone.
Repeat the same procedure as before to create another Cylinder.
The vector should be pointing in the positive ZC-direction. On the
Point Constructor window, again click on the Center icon and
construct it at the center point of the base of the cone. The
cylinder should have a diameter of 6 inches and a height of 20
inches.
The complete shaft will look as shown below. Remember to save the model.

Creating a solid model using EXTRUDE command
Extrude is defined as the process of creating a feature from a sketch by adding the material
along the direction normal to the sketch or any other specified direction.

Above Figure shows the isometric view of a closed sketch

and above Figure shows the extruded feature created using this sketch.

When you invoke the Extrude tool, the Extrude dialog box will be displayed, as shown
in Figure

You will be prompted to select the planar face to sketch or the section geometry to be
extruded. If you select the sketch at this stage, the preview of the extruded feature
created using the default values will be displayed on the screen. If you select the sketch
plane, the Sketcher environment will be invoked. Draw the sketch and exit the Sketcher
environment; the
preview of the extruded feature will be displayed in the Modeling environment.

Extrude Dialog Box Options
The options in this dialog box are discussed next.
Section Rollout
The options in this rollout are used to sketch the section or select the section. By default,both
the Sketch Section and Curve buttons will be chosen in this rollout and you will be prompted
to select the planar face to sketch or the section geometry to be extruded. These options are
discussed next.
Sketch Section
This button is used to draw the sketch for extrusion. When you choose this button, the Create
Sketch dialog box will be displayed and you will be prompted to select the object for the
sketch plane. You can select a datum plane or the face of a solid body as the sketching plane.
Curve
By default, this button is also chosen from the Section rollout and it is used to select
the already drawn section sketch.
Direction Rollout
By default, the direction of extrusion will be normal to the selected section. The buttons
in this rollout are used to define the direction of extrusion. These options are discussed next.
Vector Constructor
If you choose this button, the Vector dialog box will be displayed. You can specify
the extrude direction using this dialog box.
Inferred Vector Drop-down List
This drop-down list is used to specify the direction of extrusion. The default direction
is normal to the selected section.
Reverse Direction
This button is chosen to flip the current extrusion direction.

Limits Rollout
The options in this rollout are used to specify the start and termination of the extrusion.
These options are discussed next.
Start Drop-down List
This drop-down list allows you to specify the start point of the extrusion. You can select
the Value and Symmetric Value options from this drop-down list. The Value option allows
you to specify the distance from the sketching plane at which the extruded feature will start.
You need to enter this value in the Distance edit box. If you enter a positive value, it will be
taken as the offset value between the sketch and the start of the extrusion feature. If you enter
0,
the extruded feature will start from the sketch plane. If you enter a negative value,
the extruded feature will start from below the sketch plane. The Symmetric Value option
allows you to extrude the sketch symmetrically in both the directions of the current
sketching plane. When you select this option, the edit boxes on the right of the Start and the
End edit boxes will show identical values and the preview will also be modified dynamically.
Figure shows the preview of a sketch being extruded symmetrically in both the directions.

Preview of the symmetric extrusion
End Drop-down List
This drop-down list allows you to specify the extrusion termination in the
direction of extrusion. For the base feature, only the Value and Symmetric Value options will
be available in this drop-down list. By default, the Value option will be selected, and the
value entered last will be displayed in the Distance edit box. As a result, the sketch will be
extruded only in the specified direction. Note that you need to enter a positive value in the
Distance edit box.
Figure shows the preview of the extrusion in only one direction

Figure shows the preview of the extrusion with different values in both directions. In this
figure,the extrusion value in the upward direction is 10 and in the downward direction is -5.

Boolean Rollout
Options in this rollout allow you to select the boolean operation that you need to
perform. These options in this rollout are discussed in the next chapter.
Draft Rollout
The options in this rollout are used to specify a draft angle to the extrusion feature.
The options in this area will be available only when you select the section to extrude. Various
draft options in this rollout are discussed next.
Angle
This edit box allows you to specify the draft angle.
Draft
This drop-down list allows you to specify the type of draft to be applied to the feature.
The options in this area are discussed next.
From Start Limit
This option adds the draft from the start section to the end section of the extruded feature. As
a result, the dimension of the feature at the start section is the same as that of the original
sketch and it tapers toward the end section.
Figure shows thepreview of the extruded feature drafted using this option.

It is evident from this figure that the bottom section of the extruded feature is the same as that
of the original sketch and the feature tapers as it goes toward the top section.

From Section
This option is used to taper the extruded surface in such a way that the cross-section of the
extruded feature remains the same at the sketching plane, as shown in Figure

From Section - Symmetric Angle
This option is available only when you select the Symmetric Value option from the Limits
rollout or specify the values in both the start and the end directions. This option adds a
symmetric taper in both directions of the sketch, as shown in Figure.

In this draft type, if the distance value in one of the directions is more than the other, the
section in that direction will also be smaller in size.

From Section - Matched Ends
This option is also available only when you select the Symmetric Value option fromthe
Limits rollout or specify the values in both the start and the end directions. Thisoption
tapers the modelsuch that the end sections in both the directions are of similar size,
irrespective of the distance values in both directions, as shown in Figure

From Section - Asymmetric Angle
This option is also available only when you select the Symmetric Value option fromthe
Limits rollout or specify the values in both the start and the end directions. This option adds
different tapers in both directions of the sketch, as shown in Figure

When you select this option, the Front Angle and Back Angle edit boxes will be
available in the Draft rollout. The front and back angle values will be applied at the front and
back sides of the sketching planes used to create the extruded feature.

Offset Rollout
NX also allows you to create thin base features by extruding open or closed sketches.
For example, refer to the closed sketch shown in Figure

A thin feature created using this sketch is shown in Figure

Similarly, Figure shows an open sketch

and Figure shows the resulting thin feature.

Two-Sided
This option is used to create a thin feature by offsetting the sketch in two directions.Select
this option; the Start and End edit boxes will be displayed. If you enter the positive value in
the End edit box, the sketch will offset outward and vice-versa.
Figure shows the preview of a thin feature with an offset only in the end direction

and Figure shows the preview of the same feature with an offset in both the directions

Single-Sided
This option will be enabled only when you create a thin feature using a closed sketch
with nonested closed sketch in it. If you select this option, the inner portion of the sketch
will be filled automatically. As a result of this, there will be no cavity inside the model. It
will be similar to the solid extrusion from inside. However, you can also add some offset
to the outer side of the sketch.

Symmetric
This option is used to offset the material symmetrically on both sides of the sketch to create
the thin feature.

Settings Rollout
The options in this rollout are used to specify whether you need the extruded feature to be

a sheet body or a solid body. To get a solid body, the section must be a closed profile or an
open profile with an offset. If you use a Single-Sided offset, you will not be able to get a
sheet body.
You can select the required option from the Body Type drop-down list.
Preview Rollout This rollout is used to preview the model dynamically while modifying the
values in the Extrude dialog box. If you select the Preview check box, it will allow you to
dynamically preview the changes in the model as you modify the values of the extrusion. The
Show Result button is used to view the final model. The Undo Result button is used to go
back to the preview mode.
After setting the values in the Extrude dialog box, choose OK to create the extruded
feature and exit the dialog box. If you need to extrude more than one sketches, choose the
Apply button; the selected sketch will be extruded and the dialog box will be retained. Also,
you will be prompted to select the section geometry. Select the other sketch to extrude and
choose the OK button.
You can also set and modify the values of extrusion using the drag handles that will
be displayed in the preview of the extrusion feature, refer to Figure.

The start drag handlewill be a filled circle and the end drag handle will be an arrow. To
modify the start limit, end limit, or draft angle values, click on their respective drag handles,
and then press and hold the left mouse button and drag the mouse. You can also enter the new
values in the edit boxes that will be displayed after clicking on the respective handles. To
modify the type of limits or taper, right-click on their respective drag handles and select the
type from the shortcut menu.

Creating a solid model using REVOLVE command
The Revolve tool allows you to create a solid body by revolving a sketch around the
revolution axis, which could be a sketched line or an edge of an existing feature. Figure
below shows a sketch for the revolved feature and

Figure shows the Isometric view of the resulting feature revolved through an angle of 270degree.

To convert a sketch into a revolved body, you need to invoke the Revolve tool. This tool
works in the following three steps:
Step 1: Select the sketch to be revolved
Step 2: Select the revolution axis
Step 3: Specify the revolution parameters
To invoke the Revolve tool, choose the revolve button in the Feature dialog box; the
Revolve dialog box will be displayed, as shown in Figure

click on the picture to enlarge

The options in this dialog box are same as the options in the Extrude dialog box, except the
ones that are explained next.

Axis Rollout
The options in this rollout are used to specify the revolution axis. These options are discussed
next.
Specify Vector
The options in this area are used to specify the revolution axis using the Vector
Constructor button or the Inferred Vector drop-down list.
Vector Constructor
When you choose this button, the Vector dialog box will be displayed. You can specify
the revolution axis by using this dialog box.
Inferred Vector
This drop-down list is a shortcut to specify the revolution axis.
Reverse Direction
You can choose this button to flip the direction of revolution.
Specify Point
The options in this area are used only when you use the vector method to specify
the revolution axis.
Point Constructor
When you choose this button, the Point dialog box will be displayed. You can specify
the point to define the revolution axis using this dialog box.
Inferred Point
This drop-down list contains the snap point options that are used to automatically snap the
keypoints of the previously sketched entities or features

Limits Rollout
The options in this rollout are used to specify the start and termination angles of
revolution.These options are discussed next.

Start Drop-down List
This drop-down list allows you to specify the start angle of the revolution feature. You
can select the Value and Until Selected options from this drop-down list. The Value
option allows you to enter the value of the start angle in the Angle edit box. You need to
enter a positive value of the angle. This value will be taken as the offset value between the
sketch and the start of the revolved feature. The Until Selected option allows you to start the
revolve
feature from the selected plane, face, or body. When you select this option, the Face,
Body,Datum Plane button will be chosen and you will be prompted to select the face, body,
or datum plane to start the revolved feature.
End Drop-down List
This drop-down list allows you to specify the termination angle of the revolution feature.
You can select the Value and Until Selected options from this drop-down list. The Value
option allows you to enter the value of the end angle in the Angle edit box. You need to enter
a positive value of the angle. This value will be taken as the offset value between the sketch
and the end of the revolved feature. The Until Selected option allows you to terminate the
revolve feature using the selected plane, face, or body. When you select this option, the
Face, Body, Datum Plane button will be chosen and you will be prompted to select the face,
body, or datum plane to start the revolved feature.

The default value of the end angle is the value that you have used to create the last
revolved feature. Figure below shows a revolved feature with the start angle as 30 degree and
the end angle as 180-degree. The sketch used to create this feature is also displayed.

Note that NX uses the right-hand thumb rule to determine the direction of revolution. This
rulestates that if the thumb of your right hand points in the direction of the axis of revolution,
then the direction of the curled fingers will define the direction of revolution, refer to Figure

Figure below shows the sketch and an arrow pointing in the direction of the axis of revolution

and Figure below shows the resulting feature revolved through an angle of 180 degree.

And the sketch and an arrow pointing in the direction of the axis of revolution

the resulting feature revolved through an angle of 180-degree.

Offset Rollout
NX also allows you to create thin revolved bodies using the open and closed sketches.
This process is similar to that of creating solid extruded features. Select the Offset rollout in
the Revolve dialog box; the rollout will expand and display the Offset drop-down list. There
is only one option, Two-Sided, available in this drop-down list. Select this option; the Start
and the End edit boxes will be available. Enter the start and end offset values in the
respective
edit boxes. Figure below shows a thin revolved model with the open sketch and the
revolution axis used to create it. In this model, the start angle is 30 degree, the end angle
is 180-degree, and the start offset value is 2.

Figure below shows a thin revolved model with the closed sketch and the revolution axis
used to create it. In this model, the start angle is 45 degree, the end angle is 270-degree, and
the start offset value is 2.

Modeling a Rocker Device (Using Curves, Boss,Hole, & Mirror
commands)
In this exercise you will use curves to model the profile of this part, extrude the curves then
model the shafts.

Prerequisites

Create reference sets
The Dimensions of the Part (Units in m.m.)

In this exercise you will

Use basic curves (two circles and two arcs) to create the overall shape of this part.

Trim the curves to create the finished profile.

Extrude the profile.



Add a boss to the larger end and the smaller end, chamfer their bottom edges, add

blends



to Various edges.
Mirror the bosses and their associated features.
Create holes through the bosses at both ends of the part.

Task 1. Begin With a Standard Metric Part File
Open the standard metric part file, standard_mm, from the project sub-directory. If you
want, you can save this part file in your own directory using a name such as test_2.
The standard part file uses the following layer standards:

Solid geometry on layers 1 through 20.

Sketch geometry on layers 21 to 40

Curve geometry on layers 41 to 60

Reference geometry on layers 61 to 80

Sheet bodies on layers 81 to 100

Drafting objects on layers 101 to 120
Start the Modeling application.
Task 2. Planning the Construction of the Part
The finished part will look like this.

For the curved, plate-like shape of this part, you can extrude a profile made from curves.

Then you can add the bosses, blends, chamfers, and holes to finish the part.
Task 3. Prepare to Create the Profile on a Layer Reserved for Curves
You will want the profile of curves to be placed on a layer reserved for curves.
For this project, layers 41 through 60 are reserved for curves.
Change the work layer to layer 41.
Task 4. Change the View
Since you will be creating the profile on the XC-YC plane of the WCS, it would be helpful if
you were looking straight "down" onto this plane.
Change the view to a TOP view.
The instructions will refer to the "top" and "bottom" of the profile (top being in the +YC
direction).
Task 5. Create the Lower End of the Profile
You can use a circle to define the lower end of this profile.

Create a circle at this location.

Choose the Basic Curves icon or choose InsertCurveBasic Curve.

Choose the Circle icon on the Basic Curves dialog.

In the XC field, key in 0, then Tab.

In the YC field, key in 0, then Tab.

In the Radius field, key in 38.

Check all the values in the tool bar. Change any wrong values.

Press Enter/Return.
Task 6. Define the Upper end of the Profile
You can define the upper end of this profile with a smaller circle.

Create a smaller circle above the first.

Choose the Circle icon to start a new circle.

In the XC field, key in 50, then Tab.

In the YC field, key in 175 then Tab.

In the Radius field, key in 19, then press Enter/Return.

Fit the view.
Task 7. Create the Left Side of the Profile
There is an arc tangent to each circle that defines the left side of this profile.
You decide that you will create both arcs, then trim later to create the finished profile.

Create a fillet that is tangent between the two circles. Be sure the fillet will not trim the
circles as you create it.
If the system does not construct this fillet the way you want it, Undo it and try again with
slightly different
selection points on each circle.
? Choose the Fillet icon.
? Choose the 2 Curve Fillet icon on the Curve Fillet dialog.
? Turn both trim options off.
? In the Radius field, key in 130.
? Select the upper left side of the top circle (avoiding control points).
? Select the lower left side of the bottom circle.
? For the approximate center of this fillet, indicate between the two circles.
Task 8. Create the Right Side of the Profile
The arc on the right side will complete the basic shape of this profile.

Use the same method to ceate a fillet that is tangent between the right side of the two circles.
? In the Radius field of the Curve Fillet dialog, key in 115.
? Select the lower right side of the top circle (about where you would expect the tangency
to appear).
? Select the upper right side of the bottom circle.
? For the approximate center of this fillet, indicate between and to the right of the two circles.
Task 9. Trim the Upper Circle
Now you are ready to trim away the section of the circle you don't need.
Trim the top circle to the two arcs (fillets).
- Be sure that you will trim bounding objects.
? Choose Back on the Curve Fillet dialog.
? Choose the Trim icon on the Basic Curves dialog.
? Be sure that the Trim Bounding Objects option is on.
? On the Trim Curve dialog, be sure the selection step is set to First Bounding Object.

? For the first bounding object (working in a counter clockwise direction), select the upper
end of the right arc (fillet).
? Be sure the selection step has changed to Second Bounding Object.
? For the second bounding object, select the upper end of the left arc (fillet).
? Be sure the selection step has changed to String to Trim.
? For the string to trim, select the lower left side of the smaller circle.
Task 10. Trim the Lower Circle
You can do the same thing on the bottom circle.

Trim the bottom circle to the two arcs (fillets).
? Choose Back on the Trim Curve dialog.
? Choose the Trim icon on the Basic Curves dialog.
? For the first bounding object (working counter clockwise), select the lower end of the left
arc (fillet).
? For the second bounding object, select the lower end of the right arc (fillet).
? For the string to trim, select the upper left side of the larger circle.
This completes the profile.
Task 11. Change the View and the Work Layer
You are ready to create the plate-like solid portion of this part.
This means that you will want to have the solid on a layer reserved for solids. For this project
layers 1
through 20 are reserved for solid geometry.
Change the work layer to layer 1.
Replace the current view with a trimetric view.
Task 12. Create the Curved Plate
Eventually the part will consist of a curved plate (extruded from the profile), bosses,
chamfers, blends and
holes.
Your next task, then, is to extrude the profile you have just completed.
Extrude the profile this distance and direction.
? Choose the Extruded Body icon from the Form Feature toolbar or choose InsertForm
Feature
Extrude.
? Select all the curves in the profile (use Chain Curves.
? When the whole profile is highlighted, OK the Extruded Body dialog.
? Choose the Direction, Distance option.
? If the direction arrow points upward from the profile, choose OK to accept the default
direction.

Otherwise reverse the default direction.
? For the Start Distance, use zero.
? For the End Distance, use 18.
? Use zero for the offset and taper values.
? OK the dialog.
Task 13. Display Only the Solid
For your work on the solid, you won't want the curves to be displayed.
Make the layer with the curves, layer 41, Invisible.
Optional: Change the view to show Gray Thin Hidden Edges.
Task 14. Planning the Next Construction Steps
Eventually you will need to have these bosses on the curved plate (each with a hole
completely through it). You have decided that you will create the large and small bosses first,
add the blends and chamfers, then mirror both bosses (and their associated features) to the
lower face of the plate.
Task 15. Create a Boss at the Large End of the Plate

Create this boss on the top face of the plate at its larger end.

The position of the boss is coincident with the arc center of the rounded end of the plate.
? Choose the Boss icon from the Form Feature tool bar or choose InsertForm FeatureBoss.
? Select the top face of the solid near the larger end.
? On the Boss dialog, in the Diameter field, key in 60.
? In the Height field, key in 25.
? Use a zero taper angle.
? OK the dialog.
? On the Positioning dialog, choose the Point Onto Point icon.
? Select the top, front edge of this end of the plate
? On the Set Arc Position dialog, choose Arc Center.

Task 16. Create the Boss at the Small End of the Plate
Create this boss on the top face of the plate at its smaller end. Its position is coincident with
the arc center of this end of the plate.

? Select the top face of the solid near the smaller end.
? For the Diameter, key in 25.
? For the Height, key in 18.
? Use a zero taper angle.
? OK the dialog.
? On the Positioning dialog, choose the Point Onto Point icon.
? Select the top, rounded edge of this end of the plate.
? On the Set Arc Position dialog, choose Arc Center.
Task 17. Blend the Bottom Edges of Both Bosses
When you mirror the bosses, you will want to mirror any blends with them.
Blend the bottom edges of both bosses.
? Choose the Edge Blend icon from the Feature Operation tool bar or choose InsertFeature
OperationEdge Blend.
? In the Default Radius field, key in 4.
? Select the bottom edge of each boss.
? OK the dialog.
Task 18. Chamfer the Top Edges of the Bosses
You will also want to chamfer the top edge of each boss so that it, too, will be included in the
mirror operation.
Create a chamfer on the top edge of each boss.
? Choose the Edge Chamfer icon from the Feature Operation tool bar or choose Insert
Feature
OperationChamfer.
? On the Chamfer dialog, choose the Single Offset option.
? Select the top edge of each boss.
? OK the dialog.
? In the Offset field, key in 2.
? OK the dialog.
Task 19. Blend the Top Edge of the Plate
You must also blend some edges. You can begin with the top edge of the plate.

Blend all of the top edge of the plate.
? Choose the Edge Blend icon from the Feature Operation tool bar or choose InsertFeature
OperationEdge Blend.
? In the Default Radius field, key in 2.
? Turn the Add Tangent Edges option on.
? Select anywhere along the top edge of the plate.
? Apply the dialog.
Task 20. Blend the Bottom Edge of the Plate
The bottom edge of the plate must also be blended.

Blend the bottom edge of the plate.
? Be sure the radius is 2 mm.
? Be sure the Turn the Add Tangent Edges option on.
? Select anywhere along the bottom edge of the plate. OK the dialog.
Task 21. Preparing to Mirror the Bosses and Their Associated Features
In order to mirror all of the bosses, blends, chamfers, you will need to have a mirror plane.
You feel that a datum plane constructed between the top and bottom face of the plate would
be a good way to provide one.
You will want to place this reference feature on a layer reserved for them.
Change the work layer to layer 61.
Create a datum plane that is centered between the top and bottom faces of the plate.
? Choose the Datum Plane icon from the Form Feature tool bar or choose InsertForm
Feature
Datum Plane.
? Optional: Set the Filter to Face.
Select the top face of the plate, then the bottom face.
? Be sure the constraints are Center Plane and Parallel Plane.
? OK the dialog.
Task 22. Mirror the Bosses Along With Their Associated Features
Change the work layer back to layer 1.
Mirror the two bosses and all the blends and chamfers associated with those bosses.
? Choose the Instance Feature icon from the Feature Operation tool bar or
chooseInsertFeature OperationInstance.
? On the Instance dialog, choose the Mirror Feature option.
? On the Mirror Feature dialog, be sure the Feature To Mirror selection step is highlighted.
? In the Features in Part list box, choose the features you want to mirror (use Shift+MB1,
select the

first and last features you need).
Choose the Add arrow to move the selected features into the Features in Mirror list box.
? Choose the Mirror Plane selection step icon (use MB2).
? For the mirror plane, select the datum plane.
? OK the dialog.
Task 23. Create a Hole Through the Bosses at the Large End
You need a hole through the bosses at each end of this part.
Create a hole all the way through the upper and lower bosses (and the plate) at the larger end.

? Choose the Hole icon from the Form Feature tool bar or choose InsertForm FeatureHole.
? Choose the Simple icon.
? For the placement face, select the top face of the larger boss on the top of the plate.
? For the thru face, select the lowest face of the larger boss on the bottom of the plate.
? For the Diameter, key in 45.
? OK the Hole dialog.
? On the Positioning dialog, choose the Point Onto Point option.
? For the target object, select the inner edge of the chamfer on the top boss.
? On the Set Arc Position dialog, choose Arc Center.
Task 24. Create a Hole Through the Bosses at the Small End
You also need a hole all the way through the smaller bosses.
Create another hole all the way through the bosses (and the plate) at the smaller end of this
part.

? Be sure the Hole dialog is up.
? For the placement face, select the top face of the smaller boss.
? For the thru face, select the lower face of the smaller boss on the bottom of the plate.
? For the Diameter, key in 16
? On the Positioning dialog, choose the Point Onto Point icon.
? For the target object, select the inner edge of the chamfer on the top boss.
? On the Set Arc Position dialog, choose Arc Center.
Task 25. Create a Reference Set
Since this part will be added to an assembly, you will want to include a reference set in the
part file that includes only the solid, not the datum plane
In this company, the standard reference set name for solids is "SOLID".

Create a reference set named SOLID. Add to it only the solid body.
? Choose AssembliesReference Sets.
? Choose the Create icon.
? On the Create Reference Set dialog, key in the name, SOLID.
? OK the dialog.
? Select the solid body (check the Status Line).
? OK the Class Selection dialog.
? Cancel the Reference Sets dialog.

Exercise No. 1
Create the solid model for the machine component shown in figure 1.

Figure 1.

Exercise No. 2
Create the solid model for the machine component shown in figure 2.

Exercise No. 3
Create the solid model for the machine component shown in figure 3.

Exercise No. 4
Create the solid model for the machine component shown in figure 4.

Figure 4.

Exercise No. 5
Create the solid model for the machine component shown in figure 5.

Exercise No. 6
Create the solid model for the machine component shown in figure 6.

.

Figure 6.

Exercise No. 7
Create the solid model for the machine component shown in figure 7.

Figure 7.

Exercise No. 8
Create the solid model for the machine component shown in figure 8.

Exercise No. 9
Create the solid model for the machine component shown in figure 9.

Exercise No. 10
Create the solid model for the machine component shown in figure 10.

Exercise No. 11
SCREW JACK
Create the Screw Jack assembly as a 3D solid model.

PROCEDURE
1.
2.
3.
4.

Create the parts using Extrude and Revolve commands
For constructing holes and cutout, use hole command and cutout commands
After constructing each part save it as a separate part file with extension. par.
Assembly the various parts using the various assembly constrains (planer, design,
mate, axial align, connect etc).
5. Save the assembly as a file with extension .asm

Exercise No. 12
PLUMMER BLOCK
Create the Plummer block assembly as a 3D solid model.

PROCEDURE
1.
2.
3.
4.

Create the parts using Extrude and Revolve commands
For constructing holes and cutout, use hole command and cutout commands
After constructing each part save it as a separate part file with extension. par.
Assembly the various parts using the various assembly constrains (planer, design,
mate, axial align, connect etc).
5. Save the assembly as a file with extension .asm

Exercise No. 12
Tail Stock
Create the Tail Stock assembly as a 3D solid model.

PROCEDURE
1.
2.
3.
4.

Create the parts using Extrude and Revolve commands
For constructing holes and cutout, use hole command and cutout commands
After constructing each part save it as a separate part file with extension. par.
Assembly the various parts using the various assembly constrains (planer, design,
mate, axial align, connect etc).
5. Save the assembly as a file with extension .asm

COMPUTER AIDED MANUFACTURING (CAM)
Computer-aided Manufacturing (CAM) is the term used to describe the use of
computerized systems to control the operations at a manufacturing plant. These
computerized systems assist manufacturers in various operations such as
planning, transportation, management, and storage. CAM helps manufacturers
improve their time to market capabilities, and create precise dimensions. In this
post, you will understand how Computer-aided Manufacturing is transforming the
landscape of manufacturing.
Brief Introduction to Computer-aided Manufacturing
As a process, CAM is used after Computer-aided Design (CAD) or Computer-aided
Engineering (CAE). The model designed using CAD is sometimes used as the CAM
input. This is why it is referred as CAD-CAM. The functions of this combination is
divided into two main categories:
• Manufacturing Planning: In this process, the computer delivers information for
production planning as well as management. This may include:
o Computer Aided Process Planning (CAPP)
o Computer Assisted NC Part Programming
o Computerized Machinability Data System
o Work Standards Development
o Inventory and Production Planning
• Manufacturing Control: In the process, the computer is used to manage and
control the physical operations of the manufacturing plant. These may include:
o Shop Floor Controlling
o Process Monitoring and Controlling
o Inventory Controlling
o Production Delivery Controlling
Applications That Lend Themselves to Computer-aided Manufacturing
Following are few manufacturing applications, which are controlled by CAM:
• Flame and plasma cutting
• Laser cutting
• Hole punching or drilling
• Bending
• Sawing
• Spinning
• Pinning

• Routing and milling
• Gluing
• Picking and placing
Benefits of CAD-CAM in Manufacturing
Today, every manufacturing plant uses at least a type of CAD-CAM system to
control their operations. Here are the various advantages they can avail by using
these software applications.
• Improves Machining Capabilities: By using a CAD-CAM system, manufacturers
can improve their machining capabilities. For example, when a manufacturer takes
up a complex 3-axis machining task, they rely on the combination software to
create a tool path for machining projects such as molding. The CAM system
automates the process, and makes it easier for manufacturers to complete the
project in time.
• Improves Client Accessibility: The CAD-CAM software allows manufacturers to
receive CAD files from their customers. After receiving these files, they can set up
the machining tool path, and perform simulations, which helps them calculate the
machining cycle times. The software allows manufacturers to minimize errors,
execute projects easily, and deliver products to the market within a shorter
turnaround time.
• Helps Improve Productivity of CNC Machines: Most CAM-CAD systems provide
high–speed machine tool paths, which help manufacturers minimize their cycle
times, reduce tool and machine wear. High-speed tool paths enable manufacturers
to improve their cutting quality and accuracy. This type of high- speed machining
helps improve the productivity of the CNC machine by more than 50%.
• Helps Reduce Material Wastage: As CAM–CAD software feature simulation
features, it helps a manufacturer to visually inspect the process of machining. This
allows him to capture tool gouges, and collisions at an early phase. This feature
contributes to the overall productivity of a manufacturing set up. This also helps
them eliminate mistakes, as well as reduce material wastage.

Manual CNC programming
The need
Approximately 95 % of CNC lathes and machining centers worldwide
are used for production machining – in making parts for hydraulics,
automobiles, earthmovers, textile machinery, armaments, etc. Such
parts can be programmed manually. The vast majority of CNC shops
worldwide in fact do program such parts manually.
Industry therefore expects engineers to know manual CNC
programming. This is why updated university syllabi lay great stress
on this subject, so that students going into the manufacturing
industry are conversant with manual CNC programming.
Most of the CNC machining is turning and milling, done on CNC
lathes and machining centers. Programming involves the putting
together of codes for basic motions, cutting parameters, canned cycles
and subprograms. A programmer would use these codes on a daily
basis, so students are expected to have a working knowledge of them
when they graduate.
Programming for turning and milling using ISO standard G/M codes
for basic motions, cutting parameters, canned cycles and
subprograms. Since Fanuc CNC controls are most popular, it would
benefit the students to learn FANUC programming. Also, most CNC
trainer machines also come with FANUC CNC systems.
A CNC program can have two types of errors:
Syntax errors
Logical errors
Syntax errors are grammatical errors, like using improper codes or
omitting codes. On a machine, these would result in a stoppage of
execution because the machine is unable to understand the program.
Logical errors are ones that result in an improper part shape, like
using G00 (rapid) instead of G01 (feed). On a machine there would be
no stoppage since it understands the program, but the part and the
machine may be damaged or cause a collision.
The best way to learn manual CNC programming is by actually writing
programs and getting instant feedback on their correctness.
Programming is learnt by repeatedly trying, by trial and error.

CNC simulation software that is designed specifically for learners
will enable you to teach manual programming. Therefore, good CNC
simulation software must have these features:
1. Editor for the student to enter the program.
2. Software should support canned cycles and subprograms
3. Automatic syntax checking and display of errors, for syntax errors.
4. Graphical tool path simulation, for logical errors.

Screen shot from CADEM seeNC Turn simulation software

Screen shot from CADEM seeNC Mill simulation software

How does simulation software help?
Without simulation
software
As students are writing their
programs, teacher goes from
student to student checking
their programs and correcting
errors.

Student spends a lot of time
waiting for the teacher to come
to him, to get issues
resolved.

With simulation software
Student approaches the teacher
only if he encounters a problem
that he cannot solve with the help
of the software. Teacher's load
reduces to 10 % of what it was
before.

Most issues are resolved with the
help of the software. For big
problems, there is no waiting
because the teacher is free of
routine checking work.

Student does not understand Student fully understands the
the significance of the program
significance of the program syntax
syntax.
and how it effects the machining

Student has clue to decide on the Student is enabled to choose his
cutting tools.
choice of cutting tool and
understand how to use a tool.

After a student completes the
Teacher checks the final simulated
program, the teacher checks the tool path. May take 15 seconds
program for syntax and logical
per student.
errors. May take 15 minutes
per student.
Student writes the program
just once. There is no time or
opportunity to try alternative
programming options.

Student has the time and
motivation to try multiple
alternative methods of writing the
same program.

Student confidence in CNC
programming is poor

Student goes out fully confident
of CNC programming

Sample benchmarking programs
Following are a few examples of how manual CNC part programs are
simulated in the seeNC Mill and seeNC Turn software. Note how
canned cycles and subprograms are simulated.
Such simulation is the bare minimum requirement in any good
simulation software.
Milling
Subprogram
O1234
G17 G90 G21 G80 G40 G54 G94 G49
N10 T01 M06 (10.0 MM END MILL-ROUGH-3
FLUTE)
(POCKET MILLING)
G90 G00 G54 X0.0 Y0. S1000 M03
G43 H01 Z5.
G0 Z1
G0 G90 X50.0 Y50.0
M98 P10055
G0 G90 X-50 Y50
M98 P10055
G0 G90 X-50 Y-50
M98 P10055
G0 G90 X50.0 Y-50.0
M98 P10055
G90 M09
M05
Z100.
G0 G91 G28 Y0.0
M30
O55 (SUB PROGRAM)
G01 Z-5.0 F100
G91 G03 X-4. Y4. I-4. J0.
F200.535 X-4. Y-4. I0. J-4.
X4. Y-4. I4. J0.
X4. Y4. I0. J4.
G01 X8.
G03 X-12. Y12. I-12. J0.
X-12. Y-12. I0. J-12.
X12. Y-12. I12. J0.
X12. Y12. I0. J12.
G01 X8.
G03 X-20. Y20. I-20. J0.
X-20. Y-20. I0. J-20.
X20. Y-20. I20. J0.
X20. Y20. I0. J20.
G0 Z5.0
M99

Mirroring about X axis
O1234
G17 G90 G21 G80 G40 G54 G94 G49
N10 T01 M06 (10.0 MM END MILL-ROUGH-3

FLUTE)
(POCKET MILLING)
G90 G00 G54 X0.0 Y0. S1000 M03
G43 H01 Z5.
Z1
M98 P10055
M70
M98 P10055
M80
M05
Z100.
G0 G91 G28 Y0.0
M30
O55 (SUB PROGRAM)
G0 X75 Y75
G01 Z-5.0 F100
X80
X80. Y80.0
X70 Y80
X70 Y70
X80 Y70
X80 Y75
X85 Y85
X65 Y85
X65 Y65
X85 Y65
Y75
X90
X90 Y90
X60 Y90
X60 Y60
X90 Y60
X90 Y75
X95
X95 Y95
X55 Y95
X55 Y55
X95 Y55
X95 Y75
G0 Z1
X0 Y0
M99

Turning
G71 – Turning cycle
O1234
G0 G99 G21
G0 X300. Z50.
T0101
G97 S700 M03
X100. Z2. M08
X84.
N20 G71 U3. R0.5
N25 G71 P30 Q75 U1. W0.5 F0.3

N30 G00 X46.
N35 G01 X46. Z0.
N40 X50. Z-2.
N45 Z-45.
N50 G02 X60. Z-50. I5. K0.
N55 G01 X71.
N60 G03 X75. Z-52. I0. K-2.
N65 G01 Z-75.
N70 X80.
N75 X84. Z-75.
G0 X100.
M05
M09
G0 G28 U0.0 W0.0
M30
G76 – Threading cycle
O1234
G0 G99 G21
X300. Z50. M08
N1 T0101
M03 S2000
X100 Z2.0 M08
X84.
N20 G71 U3. R0.5
N25 G71 P30 Q75 U1. W0.5 F0.3

N30
N35
N40
N45
N50
N55
N60
N65

G00 X46.
G01 X46. Z0.
X50. Z-2.
Z-45.
G02 X60. Z-50. I5. K0.
G01 X71.
G03 X75. Z-52. I0. K-2.
G01 Z-75.

N70 X80.
N75 X84. Z-75.
G0 X100.
M05
M09
G0 G28 U0.0 W0.0
N2 T0606
G97 S1413 M04
X100. M08
X54. Z0
G76 P020060 Q10 R100
G76 X48.12 Z-35. R0 P940 Q375 F1.5
X100.
M09
M05
X200. Z10.
M30

TURNING
Program format
Program formats and commands explained in this chapter relate to the Fanuc 0iT
controller.
A CNC program consists of a number of lines, called blocks. Each block contains a
number of commands.
Block format

G01 X100.0 Z50.0 F0.2 is a block. It tells the tool to move along a straight line to
X100.0 Z50.0 at a feed rate of 0.2 mm/revolution.
A block consists of a set of words. Each word is a command. E.g., X100.0 is a word.
A word consists of an alphabet called the address, followed by a number. In X100.0, X is
an address.
Other than coordinates, the most commonly used words in a program are the G-codes
and M-codes.
G codes mostly involve tool motion commands like rapid motion, feed motion, circular
motion, dwell, and canned cycle codes.
M codes mostly involve machine actions like spindle on / off, tool change and coolant on
/ off.

Common addresses
N
Block number - specifies the start of the block
G
Preparatory functions
M
Miscellaneous functions
X
X-axis coordinate
Z
Z-axis coordinate
I
X-axis location of arc center
K
Z-axis location of arc center
R
Radius of arc
S
Spindle speed or Cutting speed
F
Feed rate
T
Tool number

Coordinate system
Axes convention
The Z axis is along the spindle, while the X axis is perpendicular to it. The program zero
is the intersection of these axes. All coordinates in a program are referenced from this
point.

Axes on a lathe
Z is along the part axis and X is normal to it.

Absolute, incremental coordinates
In Absolute programming the end point of a motion is programmed with reference to the
program zero point. Coordinates are specified as X,Z. X coordinate is the diameter of the
part.
In Incremental programming the end point is specified with reference to the current tool
position. Coordinates are specified as U,W. U is the incremental diameter of the part.
Example

Absolute traverse from P1 to P2, then to P3
X20.0 Z-10.0
X40.0 Z-15.0
Incremental traverse from P1 to P2, then to P3
U0.0 W-10.0
U20.0 W-5.0

Incremental mode programming is seldom used.
Note: All examples in this chapter are in absolute mode.

Basic motion commands
G00 - Rapid traverse
When the tool is moving to a position preparatory to executing a cutting motion or when
it is moving to the tool change position, the motion is a essentially a waste of time and is
executed as fast as possible. The motion is called Rapid traverse. The time taken to
execute a rapid motion is also called the Air cut time.
Typical rapid traverse rates are 20 to 40 m /min., but can be as high as 80 m/min.
Format
G00 X_ Z_
X, Z are the destination coordinates
Example

Rapid motion to P1
G00 X20.0 Z0.0

G01 - Linear interpolation
The tool moves along a straight line in one or two axis simultaneously at a programmed
linear speed, the feed rate.
Format
G01 X__ Z__ F__
X, Z are the destination coordinates
F is the feed rate, the speed of the linear motion

Example

Linear motion from P1 to P2, then to P3
G01 X20.0 Z-10.0 F0.2
X40.0 Z-15.0
G01 need not be repeated in the second line because it is a 'modal command' – it stays
active till it is changed by a different motion command.

G02 / G03 - Circular interpolation
Motion along a circular arc at a programmed linear speed, the feed rate. G02 moves
along a Clockwise (CW) arc, G03 moves along a Counterclockwise (CCW) arc.
An arc can be programmed using its radius or the coordinates of its center point.

Format
Using arc radius:
G02/03 X__ Z__ R__ F__
X, Z are the destination coordinates
R is the radius
F is the feed rate

Using arc center coordinates:
G02/03 X__ Z__ I__ K__ F__
X, Z are the destination coordinates
I and K are the relative distance from the arc start point to the arc center
I = X coord. of start point - X coord. of center
K = Z coord. of start point - Z coord. of center
I and K must be written with their signs

Example

Arc radius programming:
Motion from P2 to P3, then to P4
G02 X25.0 Z-10.0 R5.0 F0.25
G03 X39.0 Z-17.0 R7.0
Arc center programming:
Motion from P2 to P3, then to P4
G02 X25.0 Z-10.0 I5.0 K0.0 F0.15
G03 X39.0 I0.0 K-7.0

G32 – Threading motion
A threading motion is a motion along a straight line, but is NOT a linear interpolation
motion. The tool motion does not start immediately when the command is encountered.
It is coordinated with the rotation of the spindle - the tool starts moving when an index
pulse is received from the spindle encoder. This pulse occurs at a specific angular
position of the spindle, once in each spindle rotation. This ensures that each thread
starts at the same angular position, and each cut follows the path of the earlier cut.
The Lead is the axial distance the nut advances in one revolution of the screw, while the
pitch is the distance between adjacent threads. Lead = Pitch x No. of starts. In a single
start thread the lead is equal to the pitch.
When cutting a thread, for every revolution of the part the tool moves axially by a
distance equal to the Lead of the thread.

Format
G32 X__ Z__ F__
X, Z are the destination coordinates
F is the lead of the thread.

Example

The following program segment cuts a thread of 2 mm. pitch to a depth of 0.6 mm.,
from point P1 to 2 mm. before point P2:
G00 X19.6 Z2.0
G32 Z-8.0 F2.0
G00 X22.0
Z2.0
G00 X19.2 Z2.0
G32 Z-8.0 F2.0
G00 X22.0
Z2.0
G00 X18.8 Z2.0
G32 Z-8.0 F2.0
G00 X22.0
Z2.0
The G32 command is seldom used. The G76 canned cycle is commonly used because it
can cut a thread with multiple cuts at various depths by specifying the pitch, thread
depth, etc. in two lines.

G04 – Dwell
A dwell command results in a temporary stoppage of all axis motions for a specified
duration. The spindle motion is not affected. It is typically used when the tool has
reached the final position in an operation and needs to stay there for a few spindle
rotations to obtain good dimensional accuracy or surface finish. For example, in a
grooving operation when the tool reaches the bottom of the groove it needs to stay there
for at least one full revolution. Without a dwell it would retract back instantaneously and
result in a non-circular cross section at the groove bottom.
Format
G04 X_
X is the dwell time in seconds.
Example
G04 X1.0
This results in a dwell of 1 second.

F, S, T commands
Feedrate
The feed rate is specified in mm. per revolution.
Format
F_
F is specfied in mm. per revolution.
Example
F0.25
This means a feed rate of 0.25 mm. / rev.

Spindle rotation
Spindle rotation is started by specifying a spindle direction command and a spindle
speed command.
Spindle direction:
This is specified by an M code.
M03 : Spindle clockwise (CW)
M04 : Spindle counter-clockwise (CCW)
M05 : Spindle stop
Spindle speed:
The spindle speed is specified either as a constant surface speed or as a constant spindle
speed.
Constant surface speed
This is commanded by G96, and is always accompanied by a limiting spindle speed
command G50.
Example:
G96 S225 M03
G50 S3000
The first line commands a constant surface speed of 225 m./ min. (meters per minute)
with the spindle rotating CW.
The second one commands a limiting spindle speed of 3000 RPM.
Constant spindle speed
This is commanded by G97.
Example:
G97 S1350 M04
This results in a spindle speed of 1350 RPM, spindle rotating CCW.

Constant spindle speed is used in threading and drilling, while constant surface speed is
used in all other operations.

Tool change
The tool change command includes the tool number and the tool offset number of the
commanded tool. When the command is executed, the tool changer causes the
commanded tool to come to the cutting position. E.g., if the tool changer is a turret, it
indexes so that the commanded tool comes to the active position.
Format
Taabb
aa is the tool number
bb is the tool offset number.
The tool number and offset number must be written with leading zeros. E.g., tool
number 6 is written as 06.
Example
T0303
This means tool number 3 and offset number 3.

Program structure
Start
The first line is the % character.
The second line is the program number, written as Onnnn. E.g., O2345 means program
number 2345.

End
The last but one line is the program end command (M02 or M30).
The last line is the % character.
Block numbers
Block numbers add clarity to the program. They are written as N_
E.g.,
--N0123 G00 G90 X100.0 Y150.0
N0124 G01 Z-10.0 F250.0
N0125 X120.0
--Block numbers are optional. They can be omitted from all blocks or included in some
blocks only. Quite often block numbers are used only in tool change blocks. The leading
zero is optional. E.g., N0005 and N5 mean the same.
Comments
Comments can be inserted to add clarity to the program. They can be operation names,
tool names, instructions to the operator, etc. Comments are inserted within brackets.
Without comments a program is just a mass of alphabets and numbers and you cannot
figure out what each section of the program is doing. A comment can be in a separate
block by itself, or after a set of commands, as shown below.
(RAPID TO TOOL CHANGE POSITION)
G00 X200.0 Z150.0 M05
T0202 (GROOVING TOOL)
Modal commands
A Modal command is a command that remains active till it is canceled or changed by
another command of the same family.
E.g.,
G01 X50.0 F0.2
G01 Z-5.0 F0.2
G01 X60.0 F0.2
G00 X100.0
G01 Z-80.0 F0.2
G01 X120.0 F0.2

Here G01 and F are modal, and need not be repeated in every block. G01 remains active
till it is changed by G00. The block after G00 has it, but here F need not be repeated.
The blocks can be written as:
G01 X50.0 F0.2
Z-5.0
X60.0
G00 X100.0
G01 Z-80.0
X120.0
Sample program
This sample program is a simple full program that does a drilling operation followed by a
grooving operation.

Program block

Explanation

%

Program start character

O0998

Program number 998

G00 X200.0 Z150.0

Move to position away from part for tool change

T0101

Tool change to tool number 1 (Drill)

G97 S1200 M03

Constant spindle speed of 1200 RPM, spindle CW

M08

Coolant ON

G00 X0.0 Z2.0

Move at rapid to position for drilling

G01 Z-30.0 F0.15

Drill the hole feed rate 0.15 mm/rev.

G00 Z2.0 M09

Rapid out of hole and coolant OFF

G00 X200.0 Z150.0 M05

Rapid to tool change position and spindle OFF

T0202

Tool change to tool number 2 (Grooving tool)

G96 S180 M03

Constant spindle speed 180 m/min, spindle CW

G50 S3500

Limiting spindle speed 3500 RPM

G00 X54.0 Z-20.0 M08

Rapid to position above groove, coolant ON

G01 X30.0 F0.1

Feed to bottom of groove

G04 X1.0

Dwell 1 second

G00 X 54.0

Rapid out of groove

G00 X200.0 Z150.0 M05

Rapid to tool change position and spindle OFF

M09

Coolant OFF

M02

Program end

%

End character

Tool radius compensation (TNRC)
Tool nose radius compensation, or TNRC, is required for generating accurate profiles.
When you command the tool to move to a position, you are actually commanding the
Theoretical Tool Tip (TTT) to move to the position. When doing an operation like contour
turning, you just program the contour according to the coordinates in the part drawing.
This causes the TTT point moves along the commanded path.

TTT moving along contour
This is the point on the tool that is used as the reference point for determining tool
offsets.

Necessity of TNRC
As the tool moves along the programmed contour, the point on the tool nose radius that
is actually doing the cutting keeps changing. We actually need the nose radius to be
tangential to the part contour at the point where it is cutting, but moving the Theoretical
Tool Tip (TTT) along the contour does not ensure this. As a result, the tool leaves
unmachined material in some areas (P1 to P2 in picture) and digs into the material in
some areas (P3 to P4 in picture).

Tool path without TNRC
To get an accurate contour during machining, an alternate tool path is generated such
that the nose radius is tangential to the contour. This is the path with Tool Nose Radius
Compensation (TNRC).

Compensated tool path

Compensation commands
The compensated tool path must be either to the left or the right of the tool path
programmed with the coordinates from the part drawing. The direction of compensation
depends on the direction of motion and whether the tool is cutting on the inside or
outside of the part. In the program you can specify whether the compensation must be
to the left or right, and the controller determines the compensated tool path. The tool
nose radius too must be specified in a separate area of the memory.
The commands are:
 G41
Tool nose radius compensation Left
 G42
Tool nose radius compensation Right
 G40
Tool nose radius compensation Cancel

TNRC Left and Right
Example

Program to move along the contour in the part (red lines in the picture indicate rapid
traverse, and blue lines linear interpolation).
--------G00 G42 X20.0 Z2.0
G01 Z0.0
Z-10.0
X40.0 Z-15.0
Z-30.0
G00 G40 X60.0
---------

Subprograms
A tool path pattern that is repeated can be stored as a subprogram and called multiple
times. Using a subprogram reduces the program length and programming time, and
makes the program more readable. A subprogram looks like a normal program, but is
terminated with an M99 command at the end instead of M02 or M30. It is called from the
main program by a subprogram call command.
Format
Subprogram call:
M98 Paaabbbb
M98 = subprogram call command
aaa = number of subprogram repetitions, written as a 3 digit number
bbbb = subprogram number, written as a 4 digit number
aaa and bbbb MUST be written as 3 and 4 digit numbers respectively, if necessary by
padding them with leading zeros.
E.g., M98 P0051234.
This command calls subprogram 1234, 5 times.
If a subprogram is only called once, the aaa parameter can be omitted.
E.g., M98 P1234
This calls subprogram 1234 just once.

Example

Since the tool width is 2 mm. and the groove width is 3 mm., two plunges are required
at each groove. The tool path at each groove is:
1.
2.
3.
4.
5.
6.

Move at rapid to the start position of the groove in Z
Feed into the groove.
Rapid out of the groove
Rapid sideways to the start point of the next cut.
Feed into the groove.
Rapid out of the groove

The program segment to cut the grooves would look like this (the text in brackets is
comments, and this is exactly how you can insert comments in an actual program):
--------G00 X44.0 Z0.0 (MOVE TO START SAFE POSITION JUST ABOVE PART)
(GROOVE 1)
W-5.0 (MOVE SIDEWAYS TO POSITION FOR FIRST CUT)
G01 X30.0 F0.1
G00 X44.0
W-0.5
G01 X30.0 F0.1
G00 X44.0
(GROOVE 2)
W-5.0
G01 X30.0 F0.1
G00 X44.0
W-0.5
G01 X30.0 F0.1
G00 X44.0
(GROOVE 3)
W-5.0
G01 X30.0 F0.1
G00 X44.0
W-0.5
G01 X30.0 F0.1
G00 X44.0
(GROOVE 4)
W-5.0
G01 X30.0 F0.1
G00 X44.0
W-0.5
G01 X30.0 F0.1
G00 X44.0
(GROOVE 5)
W-5.0
G01 X30.0 F0.1

G00 X44.0
W-0.5
G01 X30.0 F0.1
G00 X44.0
--------The tool path is the same for each groove. This segment can be put in a subprogram
that is called 5 times from the main program. The main program and subprogram can be
written like this:
Main program:
--------G00 X44.0 Z0.0
M98 P0052253 (CALL SUBPROGRAM 2253, 5 TIMES)
--------Subprogram:
%
O2253 (SUBPROGRAM 2253)
W-5.0
G01 X30.0 F0.1
G00 X44.0
W-0.5
G01 X30.0 F0.1
G00 X44.0
M99 (END OF SUBPROGRAM)

Canned Cycles – single cut
A single cut canned cycle executes a sequence of motions required to perform a cut –
rapid approach to the start position, cutting motion, and rapid departure. A single block
replaces 4 motions - 1 cutting and 3 rapid. Operations normally involve the removal of
material in multiple cuts, so these cycles are seldom used. The multi-cut canned cycles
are the ones generally used.

Turning cycle - G90
This cycle does a single turning cut (along the part axis).

Straight turning
Tool path

Format
G90 X_ Z_ F_
X
Z
F

= X coordinate of end point of cut, absolute
= Z coordinate of end point of cut, absolute
= Feed rate

The end point can be specified by incremental coordinates instead of absolute
coordinates. In this case:
1. Use addresses U and W instead of X and Z.
2. Use appropriate signs with the end point, since incremental coordinates are
specified with reference to the start point.

Example

Raw material is a cylinder of 80 diameter.
--------G00 X82.0 Z2.0 (RAPID TO INITIAL POSITION)
G90 X75.0 Z-50.0 F0.2 (CUT TO DIAMETER 75)
X70.0
(CUT TO DIAMETER 70)
G00 Z2
---------

Taper turning
Tool path

Format
G90 X_ Z_ R_ F_
X
Z
R
F

= X coordinate of end point of cut, absolute
= Z coordinate of end point of cut, absolute
= Taper amount, radial.
= Feed rate

The cut starts at point P1, ends at point P2.
R = (Diameter at start of cut – Diameter at end of cut) / 2
R must be specified with the proper sign.
The end point can be specified by incremental coordinates instead of absolute
coordinates. In this case:
1. Use addresses U and W instead of X and Z.
2. Use appropriate signs with the end point, since incremental coordinates are
specified with reference to the start point.

Example

Raw material is a cylinder of 80 diameter.

--------G00 X67.0 Z1.0
G90 X65.0 Z-50.0 R-2.5 F0.25
--------Note that the R value has a small approximation here since the cut is starting at Z1.0
instead of Z0.

Facing cycle - G94
This cycle does a single facing cut (perpendicular to the part axis).

Straight facing
Tool path

Format
G94 X_ Z_ F_
X
Z
F

= X coordinate of end point of cut
= Z coordinate of end point of cut
= Feed rate

Example

Raw material is a cylinder of 120 diameter.
--------G00 X122.0 Z1.0 (RAPID TO INITIAL POSITION)
G94 X70.0 Z-3.0 F0.25(FACE TO Z-3)
Z-6.0 (FACE TO Z-6)
---------

Taper facing
Tool path

Format
G94 X_ Z_ R_ F_
X
Z
R
F

= X coordinate of end point of cut
= Z coordinate of end point of cut
= Taper amount
= Feed rate

The cut starts at point P1, ends at point P2.
R = Z coordinate of start point – Z coordinate of end point.
R must be specified with the proper sign.
Example

Raw material is a cylinder of 120 diameter.
--------G00 X122.0 Z1.0
G94 X70.0 Z-6.0 R-2.0 F0.2
---------

Threading cycle - G92
This cycle does a single threading cut.
Tool path

Format
G92 X_ Z_ F_
X
Z
F

= X coordinate of end point of thread
= Z coordinate of end point of thread
= Thread lead

Example

---------

G00 X60.0 Z2.0
G92 X59.0 Z-65.0 F3.0
X58.4
--------The G92 command, Z and F are modal values, which remain till they are changed. They
are therefore omitted in the third block.

Canned Cycles – multiple cut
A canned cycle is a single command that executes a whole machining operation that
requires repetitive tool motions. The cycle typically consists of a few blocks with data
defining the area to be machined and some cutting parameters. The coordinates of
individual tool motions are determined automatically by the machine controller and the
motions are executed. An operation that may require tens or even hundreds of blocks of
program can be written in just a few blocks.
Canned cycles in Fanuc
G71
G72
G73
G70
G74
G75
G76

Stock removal in turning
Stock removal in facing
Pattern repeat
Finish turning
Axial drilling
Radial grooving
Threading

Turning cycle – G71
This cycle generates a part shape from a cylindrical raw material, with cuts along the
axis. The cycle definition has the part shape, depth of cut, finish allowance and couple of
other parameters.
Tool path

Format
G71 U(d)_ R_
G71 P(s)_ Q(e)_ U(u)_ W_ F_
Ns _ _ _ _
_______
_______
Ne_ _ _ _
U(d)
R
P
Q
U(u)
W
F

= Depth of cut, radius value
= Retract amount, radius value
= Number of the first block of the shape
= Number of the last block of the shape
= Finishing allowance in X, diameter value
= Finishing allowance in Z
= Feed rate

The blocks after the second G71 block define the part contour A to B. Parameter P has
the number of the first block Ns and Q has the last block Ne.
Example

--------G00 X49.0 Z5.0
G71 U3.0 R0.5
G71 P10 Q20 U1.0 W0.5 F0.2
N10 G00 X15.0 Z4.0
G01 Z-5.0
G02 X25.0 Z-10.0 R5.0
G03 X39.0 Z-17.0 R7.0
G01 Z-20.0
N20 G00 X49.0

G00 Z5.0
--------The tool path defining the shape (between the blocks defined by P and Q) must start and
end beyond the raw material. In this example the start and end points are points P1 and
P2 respectively, 2 mm. away from the raw material. Note the use of block numbers in
the program example. Block numbers are optional, need not be used in every block.

Contour definition and signs of finish allowances:

In the cycle, the area that is being machined decides:
1. The signs of the finishing allowances U and W, and
2. The way the part profile is defined
In each of the cases shown above, the tool is positioned at point P before calling the
cycle and the part profile is defined from point A to B. The signs of the finish allowances
U and W are as follows.
Case 1 (Outside-Right) : U +, W +
Case 2 (Outside-Left) : U +, W Case 3 (Inside-Right) : U -, W +
Case 4 (Inside-Left)
: U -, W -

Facing cycle G72
This cycle generates a part shape from a cylindrical raw material, with cuts perpendicular
to the axis. The cycle definition has the part shape, depth of cut, finish allowance and
couple of other parameters.
Tool path

Format
G72 W(d)_ R_
G72 P(s)_ Q(e)_ U(u)_ W_ F_
Ns _ _ _ _
_______
_______
Ne_ _ _ _
W(d)
R
P
Q
U(u)
W
F

=
=
=
=
=
=
=

Depth of cut
Retract amount, radius value
Number of the first block of the shape
Number of the last block of the shape
Finishing allowance in X, diameter value
Finishing allowance in Z
Feed rate

The blocks after the second G72 block define the part contour A to B. Parameter P has
the number of the first block Ns and Q has the last block Ne.

Example

--------G00 X49.0 Z-20.0
G72 W3.0 R0.5
G72 P10 Q20 U1.0 W0.5 F0.2
N10 G00 X49.0 Z-20.0
G01 X39.0
Z-17.0
G02 X25.0 Z-10.0 R7.0
G03 X15.0 Z-5.0 R5.0
N20 G01 Z4.0
G00 X49.0
--------In this example the start and end points are points P2 and P1 respectively, 2 mm. away
from the raw material. Note that these are the reverse of the points in the G71 turning
cycle.
Contour definition and signs of finish allowances:

In the cycle, the area that is being machined decides:
3. The signs of the finishing allowances U and W, and
4. The way the part profile is defined
In each of the cases shown above, the tool is positioned at point P before calling the
cycle and the part profile is defined from point A to B. The signs of the finish allowances
U and W are as follows.
Case 1 (Outside-Right) : U +, W +
Case 2 (Outside-Left) : U +, W Case 3 (Inside-Right) : U -, W +
Case 4 (Inside-Left)
: U -, W -

Pattern repeat cycle G73
This cycle generates a part shape from raw material that is the same shape as the final
part with cuts parallel to the along the part shape. It is used when the raw material is a
casting or forging. The cycle definition has the part shape, depth of material to be
removed, number of cuts and finish allowance.

Tool path

Format
G73 U(i)_ W(k)_ R_
G73 Ps_ Qe_ U(u)_ W(w)_ F_
Ns_ _ _ _ _
________
________
Ne_ _ _ _ _
U(i) = Relief in the X axes direction
W(k) = Relief in the Z axis direction
R = Number of cuts
P = Number of first block of the shape
Q = Number of the last block of the shape
U(u) = Finishing allowance in X
W(w) = Finishing allowance in Z
F = Feed rate
Example

--------G00 X60.0 Z10.0
G73 U5.0 W5.0 R3
G73 P10 Q20 U0.5 W0.5 F0.2
N10 G00 X15.0 Z4.0
G01 Z-5.0
G02 X25.0 Z-10.0 R5.0
G03 X39.0 Z-17.0 R7.0
G01 Z-20.0
N20 G00 X49.0
G00 Z5.0
--------The tool path defining the shape (between the blocks defined by P and Q) must start and
end beyond the raw material. In this example the start and end points are points A and
B respectively, 2 mm. away from the raw material.

Contour definition and signs of finish allowances:
These are the same as in the G71 cycle.

Finish turning cycle G70
This cycle does a single finish pass along a contour that has typically already been rough
turned with a G71, G72 or G73 cycle. Nose radius compensation is automatically
activated in G70.

Tool path

Format
Ns_ _ _ _ _
________
________
Ne_ _ _ _ _
_____
_____
G70 P(s)_ Q(e)_ U_ W_
P = Number of first block of the shape
Q = Number of the last block of the shape
U = Finishing allowance in X
W = Finishing allowance in Z
If U or W are zero they can be omitted.
Example

--------G00 X49.0 Z5.0
(ROUGH TURN CONTOUR)
G71 U3.0 R0.5
G71 P10 Q60 U1.0 W0.5 F0.2
N10 G00 X15.0 Z4.0
N20 G01 Z-5.0
N30 G02 X25.0 Z-10.0 R5.0
N40 G03 X39.0 Z-17.0 R7.0
N50 G01 Z-20.0
N60 G00 X49.0
G00 X200.0 Z150.0 M05
M09
T0202 (TOOL CHANGE)
(FINISH TURN CONTOUR)
G96 S200 M03
G50 S2500
X49.0 Z5.0 M08
G70 P20 Q60 F0.15
---------

Axial drilling / grooving cycle - G74
This cycle does a peck drilling operation to drill a hole along the axis. The cycle can
actually be used to drill multiple axial holes at various positions on the radius, on a
machine with a C-axis and live tools. The explanation here is restricted to drilling a single
axial hole.

Tool path

Format

G74 R_
G74 Z_ Q_ F_
R = Retract amount at each peck

Z = Z coordinate of hole bottom
Q = Peck depth, in microns
F = Feed rate
To drill the hole in a single pass (without pecking), set Q equal to the depth of the hole.
Example

--------G00 X0 Z2.0
G74 R0.5
G74 Z-30.0 Q6000 F0.15
G00 X50.0
---------

Radial drilling / grooving cycle - G75
This cycle does a peck drilling operation for grooving or drilling perpendicular to the axis.
The cycle can actually be used to cut multiple grooves, or (on a machine with a C-axis
and live tools) drill multiple radial holes at various positions along the length,. The
explanation here is restricted to cutting a single groove.
Tool path

Format

G75 R_
G75 X_ P_ F_
R = Retract amount after each peck, radial distance
X = X coordinate of groove bottom
P = Peck depth, radial distance in microns
F = Feed rate
Example

--------G00 X54.0 Z-20.0
G75 R0.5
G75 X30.0 P3000 F0.1
G00 X100.0 Z50.0
---------

Threading cycle - G76
This cycle cuts a straight or taper thread with multiple cuts. The cycle definition has the
thread coordinates, pitch, depth of thread, etc.
Tool path

Format
G76 P(mm)(rr)(aa) Q(d min)_ R(d)_
G76X_ Z_ R(i)_ P(k)_ Q(d)_ F_
mm = No.of idle passes after the last cut. E.g., 02 would mean 2 idle passes
rr = Chamfer distance at end of thread, fraction of the lead multiplied by 10. E.g., 12
would mean a chamfer distance 1.2 times the lead.
aa = Angle of tool tip. E.g., 60 would mean a thread angle of 60 degrees.
Q(d min) = Minimum depth of cut, in microns. E.g., 0.1 mm. is written as 100.
R(d) = Finishing Allowance, radial value, in microns. E.g., 0.15 mm. is written as 150.
X,Z = coordinates of end point of thread.
R(i) = Taper value. Positive for external threads, negative for internal threads, 0 for
straight threads.
P(k) = Thread depth, radial value, in microns. E.g., 1.2 mm. is written as 1200.
Q(d) = Depth of first cut, radial value, in microns. E.g., 0.4 mm. is written as 400.
F = Lead of thread
Depth of cut calculation for equal area:

Threads are always cut with multiple cuts. In a V thread if the depths of cut are equal,
the cross sectional area of successive cuts increases and hence the cutting load too
increases. This may result in bad thread quality or insert breakage. To ensure that this
does not happen, the depths of cut are determined so that the cross sectional area is
constant – the depth of cut reduces for each successive cut. The depth of each cut is
determined using the total thread depth and the depth of the first cut.
If the depth of cut becomes too low the tool just 'rubs' against the part material and
does not cut it. Specifying the dmin. Value prevents this from happening. If the depth of
cut is smaller than the d min. value, it is clamped at this value.
Example

--------G00 X34.0 Z2.0
G76 P020060 Q100 R0
G76 X30.0 Z-39.0 R0 P1200 Q0.5 F2.0
G00 X100.0 Z50.0
---------

Typical G and M codes
G codes
G codes on a machine are decided by its controller's programming format. Machines of
different makes with the same controller will have the same set of G codes.
Sample list of G codes:
G00 Rapid traverse
G01 Linear interpolation (feed)
G02 Circular interpolation CW
G03 Circular interpolation CCW
G04 Dwell
G20 Inch unit
G21 Metric unit
G28 Automatic zero return (returns to a fixed position, typically for tool change)
G30 2nd reference point return
G32 Thread cutting (single motion)
G40 Tool nose radius compensation cancel
G41 Tool nose radius compensation left
G42 Tool nose radius compensation right
G50 Limiting spindle speed setting
G70 Finishing cycle
G71 Stock removal in turning
G72 Stock removal in facing
G73 Pattern repeating
G74 Peck drilling on Z axis / Face grooving
G75 Peck drilling on X axis / Grooving
G76 Threading cycle
G90 Single cut turning cycle
G92 Single cut threading cycle
G94 Single cut facing cycle
G98 Feed per minute
G99 Feed per revolution
G96 Constant surface speed
G97 Constant spindle speed
M-codes
Most M codes activate machine functions like the coolant, spindle, etc. These are decided
by the machine manufacturer, and depend on the features that are available on the
machine. E.g., a machine with a tailstock will have M codes for tailstock in/out. A few
(like M00, M01, M02, M98, etc.in the list below) are fixed and based on the controller.
Sample list of M codes:
M00 Program stop
M01 Optional program stop
M02 Program end
M03 Spindle ON clock wise (CW)
M04 Spindle ON counter clock wise (CCW)
M05 Spindle stop

M06
M08
M09
M30
M98
M99

Tool change
Coolant ON
Coolant OFF
End of program and reset to start
Sub program call
Sub program end

Full sample program
This is a sample program for a part with multiple operations – Rough turning, Finish
turning, Grooving and Threading. It shows how a full program is put together.
The blocks just before a tool change typically have a number of codes specific to a
particular machine, specifically the type of its tool changer and its tool change position.
They may appear odd and unfamiliar, and may be ignored for the purpose of
understanding this program. The program has been generated by a CAD/CAM software
that automatically considers the tool nose radius during contouring. Coordinates in finish
turning are calculated with nose radius compensation, and will therefore not match the
part coordinates.

Raw material : 80 dia. Bar, 2 mm. extra material for facing.
%
O1234
T0000
G0 X150.0 Z200.0
N1 T0101 (PCLNL 2525M12 R0.8)
G50 S3000
G96 S247 M03
(ROUGH FACE)
G0 X90. Z4. M07
X84.
G72 W3. R0.5
G72 P25 Q40 U0. W0.2 F0.3
N25 G0 Z0.
N30 G01 X80. Z0.

N35 X0.
N40 Z2.
G0 X90.
(ROUGH TURN)
Z2.2
X84.
G71 U3. R0.5
G71 P45 Q95 U0.4 W0.2 F0.3
N45 G00 X26.
N50 G01 X26. Z0.2
N55 Z0.
N60 X30. Z-2.
N65 Z-38.
N70 Z-40.
N75 X60. Z-55.
N80 G03 X70. Z-60. I0. K-5.
N85 G01 Z-115.
N90 X80.
N95 X84. Z-115.
G0 X90.
M09
M05
T0000
G0 X150.0 Z200.0
N2 T0202 (PCLNL 2525M16 R0.4)
G50 S3000
G96 S296 M03
(FINISH FACE)
G0 X90. Z0. M07
X30.566
G01 G41 X26.566 F0.24
X0.
Z2.2
G0 G40 X90.
(FINISH TURN)
Z1.883
X25.766
G42 Z2.
G01 X26. F0.24
Z0.
X30. Z-2.
Z-40.
X60. Z-55.
G03 X70. Z-60. I0. K-5.
G01 Z-115.
X74.4
G0 G40 X90.
M09
M05
T0000
G0 X150.0 Z200.0
N3 T0303 (25X25, 2.00W, 0.20R, 08DEPTH, LH)
G50 S3000
G96 S258 M03
(GROOVE)

G0 X34. Z-40. M07
G01 X26. F0.2
G04 X0.046
G0 X34.
M09
M05
T0000
G0 X150.0 Z200.0
N4 T0404 (THREAD 16 X 16, 60 DEG., DEPTH 3.0, LH)
G97 S1645 M04
(THREADING)
X90. Z-1. M08
X34.
G76 P020060 Q0 R0
G76 X27.44 Z-39. R0. P1280 Q404 F2.
X90.
M09
M05
T0000
G0 X150.0 Z200.0
M30
%

Drawing to machined part - steps
A common misconception is that writing the NC program is the main job
involved in CNC machining, and that knowing how to write a program is
enough to turn out parts from a CNC machine. The fact is that only a small
amount of thinking is involved in actually writing the program.
Effort in programming

The complete sequence of steps involved in generating a machined part
from the drawing is a complex process.
Steps in machining a part

TURNING EXERCIES

O 20

O 25

O 30

1. Write an ISO program for step turning operation of the component shown
in figure using canned cycles. The diameter of the work piece = 30mm

20
N1 F0.5 S1200 T0101 M06 M03
N10 G00 X30 Z2
N11 G71 U0.5 R0.5
N12 G71 P20 Q80 U0.05 W0.05
N20 G01 X20 Z0
N40 G01 X20 Z-20

20

20

N50 G01 X25 Z-20
N60 G01 X25 Z-40
N70 G01 X30 Z-40
N80 G01 X30 Z-60
N100 G28 U0 W0
N110 M05 M30

10

10

25

20

30

40

20

2. Write the part program for the CNC lathe using canned cycles for the
component shown in figure. Assume suitable cutting conditions and
cutting tools. The diameter of the work piece = 40mm.

R 15

O 30

O 20

O 25

R 15

3. Write the CNC lathe programming for a FANUC controlled machine using
canned cycles. Take the diameter of the work piece = 30mm, depth of cut
= 0.5mm, speed = 1200rpm. Assume feed and other data suitably.

20

N1 F0.5 S1200 T0101 M06 M03
N10 G00 X35 Z2
N30 G71 U0.5 R1
N35 G71 P36 Q90 U0.05 W0.05
N36 G01 X20 Z0
N50 G01 X20 Z-15

10

15

10

15

N60 G02 X25 Z-25 R15
N70 G01 X25 Z-40
N80 G03 X30 Z-50 R15
N90 G01 X30 Z-70
N100 G28 U0 W0
N110 M05 M30

O 20

4. Write a part program for a FANUC controlled CNC Lathe for the given
component using canned cycle. Take the depth of cut 0.5mm & speed 1200rpm.
Assume suitable cutting conditions and cutting tools.

O 26

R

10

15

10

10

10

13

5. Write a part program for a FANUC controlled CNC Lathe for the given
component using canned cycle. Take the depth of cut 0.5mm & speed 1200rpm.
Assume suitable cutting conditions and cutting tools.

6. Write a part program for a FANUC controlled CNC Lathe for the given
component using canned cycle. Take the depth of cut 0.5mm & speed 1200rpm.
Assume suitable cutting conditions and cutting tools.

N1 F0.2 S1200 T0101 M06 M03
N10 G00 X38 Z2
N30 G73 U5 R10
N40 G73 P50 Q130 U0.05 W0.05
N50 G01 X25 Z0
N60 G01 X25 Z-30
N70 G01 X35 Z-30
N80 G01 X35 Z-40
N90 G01 X25 Z-55
N100 G01 X25 Z-65

N110 G01 X35 Z-80
N130 G01 X35 Z-90
N140 G28 U0 W0
N150 S400 T0202 M06
N160 G00 X26 Z2
N170 G76 P010160 Q10
N180 G76 X23.44 Z-25 P1280 Q100 F2
N190 G28 U0 W0
N200 M05 M30

22

RH ISO V-Thread
M25 x 2

29

25

R 20

7. Write an ISO program for the component shown in figure using canned
cycles. The diameter of the work piece = 30mm. Take the depth of cut 0.5mm
& speed 1200rpm. Assume suitable cutting conditions and cutting tools.

15

14

14

10

24

11

1
R1

R8

8. Write the CNC lathe program for a FANUC controlled machine using subroutine
codes. Take the diameter of the work piece = 40mm, depth of cut = 0.5mm,
speed = 1200rpm. Assume feed and other data suitably.

10

10

N1 F0.2 S1200 T0101 M06 M03
N10 G00 X42 Z2
N30 M98 P12000
G28 U0 W0
N40 M05 M30
O2000;
G01 X40 Z5
G73 U12 R24
G73 P1 Q2 U0.05 W0.05

15

25

20

N1 G01 X16 Z0
G01 X16 Z-20
G03 X30 Z-28 R8
G01 X30 Z-45
G01 X40 Z-60
G01 X40 Z-68
G02 X40 Z-78 R8
N2 G01 X40 Z-88
M99

30

16

40

R

8

8

9. Write the CNC lathe programming for a FANUC controlled machine using
canned cycle. Take the diameter of the work piece = 40mm, depth of cut =
0.5mm, speed = 1200rpm. Assume feed and other data suitably.

LH V-Thread
Pitch = 2mm

10

40

40

10

10
10

10

10

10

10

20

24

16

30

35

40

R

10. Prepare part program for the CNC lathe using subroutines for the component shown
below. Assume suitable cutting conditions and cutting tools.

N1 F0.2 S1200 T0101 M06 M03
N10 G00 X42 Z2
N21 G71 U0.5 R0.5
N22 G71 P23 Q80 U0.05 W0.05
N23 G01 X0 Z0
N50 G03 X20 Z-10 R10
N60 G01 X24 Z-20
N70 G02 X35 Z-30 R20
N71 G01 X35 Z-40
N80 G03 X40 Z-52 R20
N112 G28 U0 W0
N180 T0202 M06
N190 G00 X45 Z-65

N191 G01 X40 Z-62
N200 G75 R1
N210 G75 X20 Z-77 P1000 Q1000
G28 U0 W0
N300 T0303 M06
N310 G01 X45 Z-117
N320 G01 X40 Z-117
N330 G76 P010100 Q10
N340 G76 X36.54 Z-77 P1732 Q200 F2
N350 G28 U0 W0
N500 M05 M30

11. Write an ISO part programming for the FANUC controlled CNC Lathe using
canned cycle. Work piece diameter = 30mm, Work piece material = Mild
Steel, Feed = 0.2mm/rev, Speed for turning = 1200rpm, Depth of cut =
0.5mm.

N1 F0.2 S1200 T0101 M06 M03
N20 G00 X30 Z2
N40 G71 U0.5 R0.5
N50 G71 P60 Q120 U0.05 W0.05
N60 G01 X15 Z0
N70 G01 X15 Z-10
N80 G01 X18 Z-10
N90 G01 X18 Z-45
N100 G01 X18 Z-55
N110 G02 X28 Z-70 R20
N120 G01 X28 Z-80
N140 G28 U0 W0

N150 S400 T0202 M06
N160 G00 X20 Z-50
N165 G01 X18 Z-45
N166 G75 R1
N167 G75 X10 Z-55 P1000 Q1000
N167 G28 U0 W0
N170 G00 X15 Z-45
N180 G76 P010160 Q10
N190 G76 X12.44 Z-10 P1280 Q200 F2
N210 G28 U0 W0
N300 M05 M30

10

15

18

10

N1 F0.2 S1200 T0101 M06 M03
N10 G00 X30 Z2
N30 G73 U6.5 R13
N40 G73 P50 Q120 U0.05 W0.05
N50 G01 X15 Z0
N60 G03 X18 Z-10 R12
N70 G01 X18 Z-28
N80 G01 X29 Z-38
N90 G01 X18 Z-48
N100 G01 X18 Z-66
N110 G02 X28 Z-81 R20
N120 G01 X28 Z-91
N140 G28 U0 W0

10

15

28

29

R2
0
18

RH Square-Thread
Pitch = 2mm

R 12

12. Write the CNC lathe programming for a FANUC controlled machine. Take the
diameter of the work piece = 30mm, depth of cut = 0.5mm, speed = 1200rpm.
Assume feed and other data suitably.

18

10

N150 S400 T0202 M06
N160 G00 X25 Z-18
N161 G01 X18 Z-10
N170 G76 P010100 Q10
N180 G76 X16 Z-30 P1000 Q100 F2
N190 G28 U0 W0
N200 M05 M30

14. Write an ISO part programming for the FANUC controlled CNC Lathe using
canned cycles. Work piece diameter = 30mm, Work piece material = Mild Steel,
Feed = 0.2mm/rev, Speed for turning = 1200rpm, Depth of cut = 0.5mm.

RH ISO V-Thread
M30 x 2

25

10

20

30

20

R 10

25

10

25

10

R5

40

R5

R5

15. Prepare part program for the CNC lathe using subroutines for the component shown
below. Assume suitable cutting conditions and cutting tools.

30

N1 F0.2 S1200 T0101 M06 M03
N10 G00 X40 Z0
N20 M98 P37000
N30 M05 M30

30

30

O7000;
N10 G91
N30 G01 X0 Z-30
N40 G02 X0 Z-10 R5
N60 M99

30

16. Prepare part program for the CNC lathe using subroutines for the component shown
below. Assume suitable cutting conditions and cutting tools.

L H V - Thread
Pitch 2mm

O 30

20

L H Square Thread
Pitch 2mm

40
N11 F0.2 S1200 T0101 M06 M03
N10 G00 X30 Z5
N20 G00 X30 Z-40
N30 G76 P010160 Q10
N40 G76 X28 Z0 P1200 Q100 F2
N45 G28 U0 W0
N46 T0202 M06
N50 G01 X30 Z-90
N60 G76 P010100 Q10

10

40
N70 G76 X27.44 Z-50 P1280 Q100 F2
N80 G01 X40 Z100
N85 T0303 M06
N86 G00 X40 Z-42
N87 G00 X40 Z-40
N90 G75 R1
N100 G75 X20 Z-50 P1000 Q1000
N110 G28 U0 W0
N120 M05 M30

O0001
N1 F0.2 S1200 T0101 M03 M06
N10 G00 X80 Z2
N11 G01 X80 Z0
N20 M98 P30002
N25 G01 U0 W-30
N30 G00 X85 Z2
N35 G28 U0 W0
N40 T0202 M06
N43 M98 P10003
M05
G28 U0 W0
T0303 M06
G00 X0 Z2
G01 Z-165
G00 Z2
M05
G28 U0 W0
M30

O0002
G01
G01
G02
G01
M99

U0
U0
U0
U0

W0
W-20
W-10 R5
W-30

O0003
G00 X85 Z-55
G01 X80 Z-50
G75 R1
G75 X60 Z-60 P1000

Q1000

G00 X85 Z-125
G01 X80 Z-120
G75 R1
G75 X60 Z-130 P1000

Q1000

G00 X85 Z-185
G01 X80 Z-180
G75 R1
G75 X60 Z-190 P1000

Q1000
M99

N60 M05
N70 M30

F0.2 S1200 T0101 M04
M06
G00 X0 Z2
G01 Z-90
G00 X0 Z2
G28 U0 W0
T0202 M06
G00 X50 Z0
G71 U1 R1
G71 P1 Q2 U0.01 W0.01
N1 G01 X50 Z0
G01 X50 Z-20
G03 X50 Z-40 R10
N2 G01 X50 Z-90
G00 Z2
G28 U0 W0
T0303 M06
G00 X0 Z2
G01 X50 Z-40
G76 P010160 Q10
G76 X52 Z-90 P1200
Q100 F2
M5
G00 X0 Z2
G28 U0 W0
T0404 M06
G00 X150 Z2
G71 U1 R1
G71 P3 Q4 U0.01 W0.01
N3 G01 X80 Z0
G01 X80 Z-40
G01 X100 Z-40
G01 X100 Z-50
G03 X100 Z-80 R15
G01 X100 Z-154
N4 X150 Z-154
G28 U0 W0
M05
T0505 M06
G00 X280 Z- 105
G01 X100 Z-100
G75 R1
G75 X80 Z-110 P1000
Q1000
G01 X280
G28 U0 W0
T0606 M06
G00 X180 Z-110
G76 P010160 Q10
G76 X98 Z-154 P1200
Q100 F2
G00 X180
M5
G28 U0 W0
M30

O0001
N1 F0.2 S1200 T0101 M03 M06
N10 G00 X80 Z2
N20 M98 P30002
N30 G00 X85 Z2
N35 G28 U0 W0
N36 T0202 M06
N37 G00 X85 Z-55
N38 G01 X80 Z-50
N40 M98 P10003
N50 G28 U0 W0
N60 M05
N70 M30
O0002
G01 X80 Z0
G71 U1 R1
G71 P1 Q2 U0.01 W0.01
N1 G01 U0 W0
G01 U0 W-20
G02 U0 W-10 R5
N2 G01 U0 W-30
M99
O0003
G01 U0 W0
G75 R1
G75 U-10 W-10 P1000 Q1000

G28 U0 W0
M99

MILLING
Program format
Program formats and commands explained in this chapter relate to the Fanuc 0MD
controller.
A CNC program consists of a number of lines, called blocks. Each block contains a
number of commands.

G01 X100.0 Y50.0 F450 is a block. It tells the tool to move along a straight line to
X100.0 Y50.0 at a feed rate of 450 mm/min.
A block consists of a set of words. Each word is a command. E.g., X100.0 is a word.
A word consists of an alphabet called the address, followed by a number. In X100.0, X is
an address.
Other than coordinates, the most commonly used words in a program are the G-codes
and M-codes.
G codes mostly involve tool motion commands like rapid motion, feed motion, circular
motion, dwell, and canned cycle codes.
M codes mostly involve machine actions like spindle on / off, tool change and coolant on
/ off.

Typical addresses
N
Block number - specifies the start of the block
G
Preparatory functions
M
Miscellaneous functions
X
X-axis coordinate
Y
Y-axis coordinate
Z
Z-axis coordinate
I
X-axis location of arc center
J
Y-axis location of arc center
K
Z-axis location of arc center
R
Radius of arc
S
Spindle speed or Cutting speed
F
Feed rate
T
Tool number

Coordinate system
Axes convention
The axes and their directions are defined by the Right hand rule. The Z axis is along the
spindle. +Z is from the part looking towards the spindle. The thumb points in the +X
direction, while the index finger points towards +Y. The program zero is the intersection
of the axes. All coordinates in a program are referenced from this point.
Rotary axes about X,Y and Z are called A, B and C respectively. The sign of a rotary axis
is determined by the thumb and curled fingers of the right hand. If the thumb points in
the + direction of the linear axis, the other fingers point in the + direction of the
corresponding rotary axis.

Convention for linear axes – right hand rule

Convention for rotary axes

Axes directions on VMC

Axes directions on HMC

Absolute, incremental coordinates
In Absolute programming the end point of a motion is programmed with reference to the
program zero point.
In Incremental programming the end point is specified with reference to the current tool
position.
Absolute traverse to P1, then to P2
G90 X50.0 Y20.0
X30.0 Y50.0
Absolute traverse to P1, incremental to P2
G90 X50.0 Y20.0
G91 X-20.0 Y30.0

Basic motion commands
G00 - Rapid traverse
When the tool is moving to a position preparatory to executing a cutting motion or when
it is moving to the tool change position, the motion is a essentially a waste of time and is
executed as fast as possible. The motion is called Rapid traverse, and is executed at the
rapid traverse rate that the machine is capable of. Typical rapid traverse rates on
machines are 20 to 40 m /min., but can be as high as 100 m/min. The time taken to
execute a rapid motion is also called the Air cut time.

Format
G00 X_ Y_ Z_
X, Y, Z = coordinates of destination point
The block consists of the rapid traverse command G00 followed by the destination
coordinates.
Example

G00 X120.0 Y50.0 Z10.0
This moves the tool at rapid from its current position to the center of the hole.

G01 - Linear interpolation
The tool moves along a straight line in one or two axis simultaneously at a programmed
linear speed, the feed rate.

Format
G01 X_ Y_ Z_ F_
X, Y, Z = coordinates of destination point
F = Feed rate
The block consists of the linear interpolation command G01 followed by the destination
coordinates and the feed rate.
Example

G01 X-145.5 Y-50.0 F250.0
This does a linear interpolation motion from point P1 to P2 at a feed rate of 250
mm/min.

G02 / G03 - Circular interpolation
The tool moves along a circular arc at a programmed linear speed, the feed rate.

Clockwise - G02

Counterclockwise - G03

An arc can be programmed using its radius or the coordinates of its center point.
Format
Command format using arc radius:
G02/03 X__ Y__ R__ F__
X, Y = coordinates of destination point
R = radius of arc
F = feed rate

Arc radius programming

Command format using arc center coordinates:
G02/03 X__ Y__ I__ J__ F__

X, Z are the destination coordinates
I and J are the relative distance of the arc center with respect to the start point
I = X coord. of center - X coord. of start point of arc
J = Y coord. of center - Y coord. of start point of arc
I and J must be written with their signs

Arc center programming

Example

Arc radius programming:
G02 X-120.0 Y60.0 R35.0 F300.0
G03 X-50.0 R35.0
This moves the tool along the groove from point P1 to P2. The Y coordinate and feed rate
need not be specified in the second block since they are modal and same as in the first
block. Note the calculation of the arc radius for the center of the arc.

Example – arc radius programming:
G02 X-120.0 Y60.0 I35.0 J0 F300.0
G03 X-50.0 I35.0 J0

G04 – Dwell
A dwell command results in a temporary stoppage of all axis motions for a specified
duration. The spindle motion is not affected. It is typically used when the tool has
reached the final position in an operation and needs to stay there for a few spindle
rotations to obtain good dimensional accuracy or surface finish. For example, in a
countersinking operation when the tool reaches the final position and needs to stay there
for at least one full revolution.
Format
G04 X_
X is the dwell time in seconds.
Example
G04 X1.0
This results in a dwell of 1 second.

F, S, T commands
Feedrate
The feed rate is specified in mm. per minute.
Format
F_
F is specfied in mm. per minute.
Example
F250.0
This means a feed rate of 250 mm/min.

Spindle rotation
Spindle rotation is started by specifying a spindle direction command and a spindle
speed command.
Spindle direction:
This is specified by an M code.
M03 : Spindle clockwise (CW)
M04 : Spindle counter-clockwise (CCW)
M05 : Spindle stop
Spindle speed:
The spindle speed is specified in rpm with the address S.
Example
S1250 M03
This block commands a spindle speed of 1250 rpm with the spindle rotating clockwise.

Tool change
The tool change command typically has the tool number and a tool change command.
When the command is executed, the tool changer causes the commanded tool to come
to the spindle.
Format
Taa
M06
aa is the tool number
M06 is the tool change command
Example
23 M06

Cutter radius compensation (CRC)
When you command the tool to move to a position, you are actually commanding the
axis of the tool to move to the position. To mill a part along a contour, however, what
you actually need is for the periphery of the tool to move along the contour, which
means the center should be offset from the contour.

Necessity of CRC

The extra calculations to be
prone and time-consuming.
you to program for the part
side of compensation – Left
moves the tool along it.

made to determine the offset contour can be tedious, error
CNC controllers fortunately have a CRC feature that enables
coordinates that are available in the drawing, and specify the
or Right. The controller determines the offset contour and

The compensated tool path must be either to the left or the right of the tool path
programmed with the coordinates from the part drawing. The direction of compensation
depends on the direction of motion and whether the tool is cutting on the inside or
outside of the part. The tool diameter too must be specified in a separate area of the
memory.
The commands are:
G41 Cutter radius compensation Left
G42 Cutter radius compensation Right
G40 Cutter radius compensation Cancel

CRC Left and Right

Format
G00 / G01 G41 Dnn X_ Y_ for compensation Left
G00 / G01 G42 Dnn X_ Y_ for compensation Right
G00 / G01 G40 X_ Y_ for compensation Cancel
H is the tool offset number, under which the tool's radius is stored in the memory.
The command is initiated or cancelled with a G00 or G01 motion.

Example

--------G01 G42 D23 X0 Y0 F380.0
X0 Y0
X120.0
Y55.0
G03 X105.0 Y70.0 R15.0
G01 X 15.0
G03 X0 Y55.0 R15.0
G01 Y-10.0
G40 X-50.0 Y-15.0
--------The tool starts at point P1 (X-50.0,Y-15.0) and goes around the part clockwise cutting
the shoulder. It then goes back to P1. Offset number 23 has the tool radius value of 16.
The ----- before and after these example blocks are to show that this is just a segment
of the program and not the complete program, and there are program blocks before and
after these example blocks.

Tool length compensation
Tools used in machining a part are of different lengths. It would be extremely tedious to
write the program with these lengths taken into consideration.

Necessity of length compensation
In this picture, for example, to move to the position Z0, the programed coordinate would
be Z80, Z160, Z100 and Z200 for tools T1 to T4 respectively. Each time that a tool got
worn out and you had to change it , you would have to change the Z coordinates in the
whole program.
To eliminate this problem, machines have a length compensation feature. The program is
written for the drawing coordinates, without considering tool lengths lengths. The
lengths are entered in the controller's memory. The controller does the job of adjusting
for the tool length. A rapid motion to the coordinate Z0, for example, would be
programmed as G00 Z0 irrespective of which tool is used.

Format
G00 / G01 G43 Hnn
G43 is the length compensation activation command.
H is the tool offset number, under which the tool's length is stored in the memory.
G43 is initiated or cancelled with a G00 or G01 motion.
The tool length compensation must be activated with the first motion after every tool
change.
Example
G00 G43 H16

Program structure
Start
The first line is the % character.
The second line is the program number, written as Onnnn. E.g., O2345 means program
number 2345.

End
The last but one line is the program end command (M02 or M30).
The last line is the % character.
Block numbers
Block numbers add clarity to the program. They are written as N_
E.g.,
--N0123 G00 G90 X100.0 Y150.0
N0124 G01 Z-10.0 F250.0
N0125 X120.0
--Block numbers are optional. They can be omitted from all blocks or included in some
blocks only. Quite often block numbers are used only in tool change blocks. The leading
zero is optional. E.g., N0005 and N5 mean the same.
Comments
Comments can be inserted to add clarity to the program. They can be operation names,
tool names, instructions to the operator, etc. Comments are inserted within brackets.
Without comments a program is just a mass of alphabets and numbers and it is difficult
to figure out what each section of the program is doing. A comment can be in a separate
block by itself, or after a set of commands, as shown below.
(RAPID TO TOOL CHANGE POSITION)
G00 X200.0 Z150.0 M05
T0202 (GROOVING TOOL)
Modal commands
A Modal command is a command that remains active till it is canceled or changed by
another command of the same family.
E.g.,
G01 X50.0 F225.0
G01 Y-5.0 F225.0
G01 X60.0 F225.0
G00 X100.0
G01 Y-80.0 F225.0
G01 X120.0 F225.0

Here G01 and F are modal, and need not be repeated in every block. G01 remains active
till it is changed by G00. The block after G00 has it, but here F need not be repeated.
The blocks can be written as:
G01 X50.0 F225.0
Y-5.0
X60.0
G00 X100.0
G01 Y-80.0
X120.0
Sample program
This sample program is a simple full program that does a drilling operation followed by a
grooving operation.

Program block

Explanation

%

Program start character

O998

Program number 998

G00 G91 G28 Y0 Z0

Move to position away from part for tool change

T01 M06

Tool change to tool number 1 (16 dia. End mill)

S500 M03

Spindle speed 500 RPM, CW

G00 X-32.0 Y-40.0 M08

Move at rapid to position for milling, coolant ON

G43 H1 Z-3.0

Rapid to depth for first cut

G01 Y40.0 F350.0

Cut 1

G00 Z-6.0

Rapid to depth for second cut

G01 Y-40.0

Cut 2

G00 Z2.0 M05

Rapid above part and spindle OFF

M09

Coolant OFF

G00 G91 G28 Y0 Z0

Rapid to tool change position and spindle OFF

T02 M06

Tool change to tool number 2 (Drill)

S1400 M03

Spindle speed 1400 RPM, CW

G00 X0 Y0 M08

Rapid to hole position, coolant ON

G43 H2 Z3.0

Rapid above part

G01 Z-23.0 F200.0

Feed into hole

G00 3.0

Rapid out of hole

G00 X-64.0 Y0

Rapid to next hole position

G01 Z-23.0 F200.0

Feed into hole

G00 3.0

Rapid out of hole

M05

Spindle OFF

G00 G91 G28 Y0 Z0 M09

Rapid to tool change position and coolant OFF

M02

Program end

%

End character

Subprograms
A tool path pattern that is repeated can be stored as a subprogram and called multiple
times. Using a subprogram reduces the program length and programming time, and
makes the program more readable. A subprogram looks like a normal program, but is
terminated with an M99 command at the end instead of M02 or M30. It is called from the
main program by a subprogram call command.
Format – subprogram call:
M98 Paaabbbb
M98 = subprogram call command
aaa = number of subprogram repetitions, written as a 3 digit number
bbbb = subprogram number, written as a 4 digit number
aaa and bbbb MUST be written as 3 and 4 digit numbers respectively, if necessary by
padding them with leading zeros.
E.g., M98 P0051234.
This command calls subprogram 1234, 5 times.
If a subprogram is only called once, the aaa parameter can be omitted.
E.g., M98 P1234
This calls subprogram 1234 just once.
Example:

Since the tool diameter is 80 mm. and the width of the plate is 100 mm., two cuts are
required at each depth. The tool path at each cut is:



Rapid downwards 1 mm. in Z.
Feed right till tool periphery is a little beyond the material.





Feed up till tool periphery is a little beyond the material.
Feed left till tool periphery is a little beyond the material.
Rapid down to start position.

The program segment to face mill this part would look like this (the text in brackets is
comments, and this is exactly how you can insert comments in an actual program):
--------G00 X-45.0 Y35.0 (RAPID TO BOTTOM LEFT OF PART)
Z4.0 (RAPID TILL TOP OF PART)
(CUT 1)
G91 G00 Z-1.0 (MOVE 1 MM. DOWNWARDS)
G90 G01 X165.0 F300.0
Y70.0
X-45.0
G00 Y35.0
(CUT 2)
G91 G00 Z-1.0 (MOVE 1 MM. DOWNWARDS)
G90 G01 X165.0 F300.0
Y70.0
X-45.0
G00 Y35.0
(CUT 3)
G91 G00 Z-1.0 (MOVE 1 MM. DOWNWARDS)
G90 G01 X165.0 F300.0
Y70.0
X-45.0
G00 Y35.0
(CUT 4)
G91 G00 Z-1.0 (MOVE 1 MM. DOWNWARDS)
G90 G01 X165.0 F300.0
Y70.0
X-45.0
G00 Y35.0
--------Note that the tool path is the same for each cut. This segment can be put in a
subprogram that is called 4 times from the main program. The main program and
subprogram can be written like this:
Main program:
--------G00 X-45.0 Y35.0
Z4.0
G01 Z0 F250.0
M98 P0042456 (CALL SUBPROGRAM 2456, 4 TIMES)

--------Subprogram:
%
O2456 (SUBPROGRAM 2456)
G91 G00 Z-1.0
G90 G01 X165.0 F300.0
Y70.0
X-45.0
G00 Y35.0
M99 (END OF SUBPROGRAM)

Canned cycles
A canned cycle is a single command that executes a machining operation that is a
sequence of tool motions. The cycle typically consists of a block with data defining the
operation, like the safe approach position, final depth, etc. Once a cycle is programmed,
it is executed automatically at whichever X,Y position the tool is moved to. There is no
need to repeat the cycle at each position. The cycle is canceled with a specific cancel
command.
Canned cycles in Fanuc
G81
G82
G73
G83
G76
G84
G85
G87
G80

Drilling
Counterboring
Peck drilling
Deep drilling
Finish boring
Tapping
Reaming
Back boring
Cancel cycle

Drilling cycle - G81
Parameters in cycle

Tool path

1. Rapid to safe position above hole.
2. Feed to bottom of hole.
3. Rapid to safe height above hole.
Format
G81 X_ Y_ Z_ R_ F_
X, Y = hole position
Z = Hole depth
R = Initial safe position
F = Feed rate

Example

--G81 X20.0 Y25.0 Z-22.0 R2.0 F250.0
X75.0
Y60.0
X20.0
G80
--The tool can also be moved to the position of the first hole before calling the cycle, and
the X,Y coordinates omitted from the cycle block.
E.g., the cycle block in the example can also be written as:
G90 G00 X20.0 Y25.0
G81 Z-22.0 R2.0 F250.0

Counterboring cycle - G82
Parameters in cycle

Tool path

1.
2.
3.
4.

Rapid to safe position above hole.
Feed to bottom of hole.
Dwell.
Rapid to safe position above hole.

Format
G82 X_ Y_ Z_ R_ P_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
P = Dwell time at bottom of hole, seconds x 1000
F = Feed rate
Example

--G82 X20.0 Y25.0 Z-4.0 R2.0 P1500 F250.0
X75.0
Y60.0
X20.0
G80
---

Peck drilling cycle - G73
Parameters in cycle

Tool path

1.
2.
3.
4.
5.

Rapid to safe position above hole.
Feed by peck depth distance.
Rapid retract by 0.5 mm.
Repeat steps 2 and 3 till bottom of hole.
Rapid to safe position above hole.

Format
G73 X_ Y_ Z_ R_ Q_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
Q = Depth of each peck
F = Feed rate
Example

--G73 X20.0 Y25.0 Z-42.0 R2.0 Q10.0 F250.0
X75.0
Y60.0
X20.0
G80
---

Deep drilling cycle - G83
Parameters in cycle

Tool path

1.
2.
3.
4.
5.
6.
7.

Rapid to safe position above hole.
Feed into hole by peck depth distance.
Rapid retract to safe height above hole.
Dwell for chips to get thrown off.
Rapid into hole to 0.5 mm. above earlier feed depth.
Repeat steps 2 to 5 till bottom of hole.
Rapid retract to safe position above hole.

Format
G83 X_ Y_ Z_ R_ Q_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
Q = Depth of each peck
F = Feed rate

Example

--G83 X20.0 Y25.0 Z-42.0 R2.0 Q10.0 F250.0
X75.0
Y60.0
X20.0
G80
---

Finish boring cycle - G76
Parameters in cycle

Tool path

1.
2.
3.
4.
5.
6.

Rapid to safe position above hole.
Feed to bottom of hole.
Dwell (if required, for a blind hole).
Oriented spindle stop (the spindle stops at a particular angle).
Rapid sideways shift to disengage the tip from the bore wall.
Rapid to safe position above hole.

Format
G76 X_ Y_ Z_ R_ Q_ P_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
Q = Shift amount at bottom of hole
P = Dwell time at bottom of hole
F = Feed rate

Example

--G76 X20.0 Y25.0 Z-14.0 R2.0 Q1.0 F250.0
X75.0
Y60.0
X20.0
G80
--There is no dwell required at the bottom since this is a through hole. P is therefore
omitted.

Tapping RH cycle - G84
This cycle does a Right hand thread. It needs a floating tap holder.
Parameters in cycle

Tool path

1.
2.
3.
4.
5.
6.
7.

Rapid to safe position above hole.
Start rotation CW
Feed to bottom of hole.
Spindle stop.
Dwell (seldom used)
Start rotation CCW
Feed to safe position above hole.

Format
G84 X_ Y_ Z_ R_ P_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
P = Dwell time at bottom of hole
F = Feed rate

Example

--G84 X20.0 Y25.0 Z-14.0 R2.0 P1000 F250.0
X75.0
Y60.0
X20.0
G80
--The feed rate must be = Thread pitch x spindle RPM.

Tapping LH cycle - G74
This cycle does a Left hand thread. It needs a floating tap holder.

Parameters in cycle

Tool path

1.
2.
3.
4.
5.
6.
7.

Rapid to safe position above hole.
Start rotation CCW
Feed to bottom of hole.
Spindle stop.
Dwell (seldom used)
Start rotation CW
Feed to safe position above hole.

Format
G74 X_ Y_ Z_ R_ P_ F_
X, Y = Hole position
Z = Hole depth

R = Initial safe position
P = Dwell time at bottom of hole
F = Feed rate
Example

--G74 X20.0 Y25.0 Z-14.0 R2.0 P1000 F250.0
X75.0
Y60.0
X20.0
G80
--The feed rate must be = Thread pitch x spindle RPM.

Reaming cycle - G85
Parameters in cycle

Tool path

1. Rapid to safe position above hole.
2. Feed to bottom of hole.
3. Feed to safe position above hole.
Format
G85 X_ Y_ Z_ R_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
F = Feed rate

Example

--G85 X20.0 Y25.0 Z-14.0 R2.0 F250.0
X75.0
Y60.0
X20.0
G80
---

Back boring cycle - G87
Parameters in cycle

Tool path

1. Oriented spindle stop (the spindle stops at a particular angle).
2. Rapid sideways to a position that will enable the tool to enter the bore.
3. Rapid to safe position beyond end of bore.
4. Rapid sideways to align tool axis and bore axis.
5. Spindle start.
6. Feed to spotface depth.
7. Dwell.
8. Rapid to safe position beyond end of bore.
9. Oriented spindle stop.
10. Rapid sideways to a position that will enable the tool to enter the bore.
11. Rapid out of the bore.
Format
G87 X_ Y_ Z_ R_ Q_ P_ F_
X, Y = Hole position
Z = Hole depth
R = Initial safe position
Q = Lateral shift

P = Dwell at bottom of hole, seconds x 1000
F = Feed rate
Example

--G87 X20.0 Y25.0 Z-10.0 R-14.0 Q4.0 P1000 F250.0
X75.0
Y60.0
X20.0
G80
---

Return after cycle – G98, G99
After machining a hole the tool can be made to either return to the safe Z position
specified as R_, or to its initial Z position before the cycle was commanded.
This is done by specifying a G98 or G99 command along with the hole position block.
G98 = return to initial position
G99 = return to R position
Tool path

Example

G90 G00 X20.0 Y15.0
Z12.0
G99 G81 Z-10.0 R2.0 Q4.0 F250.0
Y35.0
Y55.0
G98 Y75.0 (RETURN TO INITIAL POSITION, TO CROSS OVER PROJECTION)
G99 X75.0
Y55.0
Y35.0
G98 Y15.0
G80
---

G98 and G99 are used in a similar manner in all cycles. G99 is default, and is active if
you do not specify either of the commands - the tool returns to the safe position. All the
previous canned cycle examples do not have either command, and the tool will return to
the safe position in all these cases.
G98 and G99 work for all cycles except G87 - Back boring. In G87 the safe position is at
the back of the hole, and the tool always moves to it after machining the back bore.
After each hole it always moves out of the hole to the initial position.

Typical G and M codes
G codes
G codes on a machine are decided by its controller's programming format. Machines of different
makes with the same controller will have the same set of G codes.
Sample list of G codes
G00 Positioning rapid traverse
G01 Linear interpolation (feed)
G02 Circular interpolation CW
G03 Circular interpolation CCW
G04 Dwell
G20 Inch unit
G21 Metric unit
G28 Automatic zero return
G30 2nd reference point return
G32 Thread cutting (single motion)
G40 Tool radius compensation cancel
G41 Tool radius compensation Left
G42 Tool radius compensation Right
G54-59 Work coordinate system
G73 Peck drilling cycle
G76 Finish boring cycle
G80 Cancel cycle cycle
G81 Drilling cycle
G82 Counterboring cycle
G83 Deep drilling cycle
G84 Tapping cycle
G85 Reaming cycle
G87 Back boring cycle
G90
G91
G94
G95
G98
G99

Absolute mode
Incremental mode
Feed per minute
Feed per revolution
Return to initial point in canned cycle
Return to safe position point in canned cycle

M-codes
Most M codes activate machine functions like the coolant, spindle, etc. These are decided by the
machine manufacturer, and depend on the features that are available on the machine. E.g., a
machine with a pallet changer will have an M code for pallet change. A few (like M00, M01, M02, M98,
etc. in the list below) are fixed and based on the controller.
Sample list of M codes
M00 Program stop
M01 Optional program stop
M02 Program end
M03 Spindle ON clock wise (CW)

M04
M05
M06
M08
M09
M30
M98
M99

Spindle ON counter clock wise (CCW)
Spindle stop
Tool change
Coolant ON
Coolant OFF
End of program and reset to start
Sub program call
Sub program end

Full sample program
This is a sample program for a part with multiple operations – Face milling, Spot drilling,
Drilling and Tapping. It shows how a full program is put together.
The blocks just before a tool change typically have a number of codes specific to a
particular machine, specifically the type of its tool changer and its tool change position.
They may appear odd and unfamiliar, and may be ignored for the purpose of
understanding this program.

%
O1234
G21 G94
N1 G0 G90 G53 G49 Z0 H0
T1 M6 (50.00 MM. DIA. ROUND INSERT - FACE MILL)
(FACE MILLING)
S803 M3
G90 G00 G54 X-30. Y22.
G43 H1 Z100. M08
Z8.
G01 Z5. F315
M98 P0020055
G90 G00 Z8.
M5
Z100. M09
N2 G0 G90 G53 G49 Z0 H0
T2 M6 (10.00 MM. DIA. SPOT DRILL)
(CENTER DRILLING)
G54 X20. Y25. S891 M3
G43 H2 Z100. M08.

G99 G81 Z-2.5 R3. F89
M98 P0056
M5
Z100. M09
N3 G0 G90 G53 G49 Z0 H0
T3 M6 (6.70 MM. DIA. TWIST DRILL)
(DRILL HOLE FOR TAP)
G54 X20. Y25. S1330 M3
G43 H3 Z100. M08
G99 G81 Z-18.013 R3. F172
M98 P0056
M5
Z100. M09
N4 G0 G90 G53 G49 Z0 H0
T4 M6 (M8.00 X 1.25 TAP)
(TAPPING)
G54 X20. Y25. S596 M3
G43 H4 Z100. M08
G99 G84 Z-14. R3. F745.
M98 P0056
M5
Z100. M09
X100. Y100.
M30
O55 (SUB PROGRAM – FACE MILLING)
G01 G91 Z-2.5 F360.0
G90 X125.
Y63.
X-30.
Y22.
M99
O56 (SUB PROGRAM - HOLES)
X75.
Y60.
X20.
G80
M99
%

Drawing to machined part - steps
A common misconception is that writing the NC program is the main job involved in CNC
machining, and that knowing how to write a program is enough to turn out parts from a
CNC machine. The fact is that only a small amount of thinking is involved in actually
writing the program.

The complete sequence of steps involved in generating a machined part from the
drawing is:

CNC MILLING PROGRAMS
1. Write a CNC Milling program for a FANUC controlled machine for the given
component. Take the depth of cut 3mm, speed 1200rpm. Assume suitable feed.
10
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50
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N10 G94 G90
N20 F100 S1200 T1 M06
N20 G00 X10 Y10 Z0
N30 G01 X10 Y10 Z-3
N40 G01 X10 Y55
N50 G01 X20 Y75
N60 G01 X75 Y75
N70 G01 X75 Y25
N80 G02 X60 Y10 R15
N90 G01 X10 Y10
N100 G01 Z3
N120 M05 M30

15

2. Write a CNC Milling program for a FANUC controlled machine for the given
component. Use Incremental coordinate system. Take the depth of cut 1mm, speed
1200rpm. Assume suitable feed.
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15
N10 G94 G90
N20 F100 S1200 T1 M06
N30 G00 X10 Y10 Z2
N40 G00 X10 Y10 Z0
N42 G91
N50 G01 Z-1
N60 G01 X15 Y0
N70 G02 X15 Y0 R7.5
N80 G01 X10 Y0
N90 G01 X10 Y10
N100 G01 X0 Y20
N110 G01 X-10 Y5
N120 G01 X-15 Y0
N130 G02 X-10 Y0 R5
N140 G01 X-15 Y0
N150 G01 X0 Y-10
N160 G01 X5 Y-10
N170 G01 X-5 Y-10
N180 G01 X0 Y-5
N190 G01 Z5
N200 M05 M30
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3. Write a CNC Milling program for a FANUC controlled machine for the given
component. Take the depth of cut 3mm, speed 1200rpm. Assume suitable feed.
Profile milling depth of cut = 1mm. Circular pocket milling – 5mm deep
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O 30
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0
R1

10

30
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N10 G94 G90
N20 F100 S1200 T1 M06
N30 G00 X10 Y10 Z0
N40 G01 X10 Y10
N50 G01 X20 Y10
N55 G01 Z-1
N60 G01 X60 Y10
N70 G03 X70 Y20 R10
N80 G01 X70 Y60
N90 G01 X60 Y70
N100 G01 X20 Y70
N110 G01 X10 Y60
N120 G01 X10 Y20
N130 G03 X20 Y10 R10
N140 G01 Z2
N150 G01 X40 Y40
N160 G66 P9016
X40 Y40 I15 Q0 Z-5 R1 K-5 F100
G67
N170 G01 Z5
N180 M05 M30

4. Write a CNC Milling program for a FANUC controlled machine for the given
component. Take the depth of cut 3mm, speed 1200rpm. Assume suitable feed.
Profile milling depth of cut = 1mm. Rectangular pocket milling – 5mm deep
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N10 G94 G90
N20 F100 S1200 T1 M06
N30 G00 X10 Y10 Z0
N40 G01 X10 Y10 Z-1
N50 G01 X40 Y10
N60 G02 X60 Y10 R10
N70 G01 X80 Y10
N80 G01 X80 Y30
N90 G01 X60 Y40
N100 G01 X80 Y50
N110 G01 X80 Y70
N120 G01 X55 Y70
N130 G02 X35 Y70 R10
N140 G01 X10 Y70
N150 G01 X10 Y50
N160 G01 X20 Y50
N170 G01 X20 Y30
N180 G01 X10 Y30
N190 G01 X10 Y10
N200 G01 Z5
N210 G01 X40 Y40
N220 G66 P9020
X40 Y40 I20 J15 Q0 Z-5 R1 K-5
G67
N230 Z5
N240 M05 M30

0
R1

30
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5. PROFILE MILLING Depth of cut - 0.4 mm and Total Depth - 2 mm, Cutting Speed: 1200 rpm,
feed: 200 mm/min

MIRROR PROGRAM : X MIRROR, Y
MIRROR
O0001
N1 F200 S1200 T01 M06 M03
N2 G00 X0 Y0 Z2
N3 G01 Z0
N4 M98 P2 0002
M71
(X MIRROR)
G01 Z0
M98 P2 0002
M70 (– X MIRROR CANCEL)
M71 (- X MIRROR TO THE SECOND)
G01 Z0
M98 P2 0002
M70 (– MIRROR CANCEL)
M81 (– Y MIRROR)
G01 Z0
M98 P2 0002
M80 (– Y MIRROR CANCEL)
M5
G00 Z50
M30

O0002
G91 G01 Z-1
G90 X0 Y10
X20 Y20
X20 Y30
X0 Y40
X0 Y60
X10 Y60
G03 X30 Y60 R10
G01 X50 Y60
G01 X50 Y20
G01 X40 Y0
G03 X20 Y0 R10
G01 X0 Y0
M99

O0001
N1 F200 S1200 T01 M06 M03
N2 G00 X0 Y0 Z2
N3 G01 Z0
N4 M98 P2 0002
M71
G01 Z0
M98 P2 0002
M70
M5
G00 Z50
M30

O0001
N1 F200 S1200 T01 M06 M03
N2 G00 X0 Y0 Z2
N3 G01 Z0
N4 M98 P2 0002
M71
M70
M81
G01 Z0
M98 P2 0002
M80
M5
G00 Z50
M30

O0002
G91 G01 Z-1
G90 X0 Y10
X20 Y20
X20 Y30
X0 Y40
X0 Y60
X10 Y60
G03 X30 Y60 R10
G01 X50 Y60
G01 X50 Y20
G01 X40 Y0
G03 X20 Y0 R10
G01 X0 Y0
M99

O0002
G91 G01 Z-1
G90 X0 Y10
X20 Y20
X20 Y30
X0 Y40
X0 Y60
X10 Y60
G03 X30 Y60 R10
G01 X50 Y60
G01 X50 Y20
G01 X40 Y0
G03 X20 Y0 R10
G01 X0 Y0
M99

6. Drilling Cycles

F200 S1200 T02 M06 M03
G00 X0 Y0 Z2
G81 X20 Y20 Z-10 R1 F100
X30 Y30
G00 Z50
G00 Z2
G83 X40 Y20 Z-10 R2 Q1
X40 Y40
X20 Y40
M5
G00 Z50
M30

N1 F200 S1200 T01 M03
G00 X5 Y5 Z0
M98 P3 0002
M98 P2 0003
M5
G00 Z50
M30

O0002
G81 X10 Y10 Z-10 R1
F100
G90 G00 Z0
G91 G00 X0 Y10
M99

O0003
G81 X10 Y10 Z-10 R1
F100
G90 G00 Z0
G91 G00 X10 Y0
M99

Other Sample Exercises
F200 S1200 T02 M06 M03
G73 X40 Y20 Z-10 R2 Q1
X40 Y40
X20 Y40
M5
G00 Z50
M30

N1 F200 S1200 T01 M03
G00 X5 Y5 Z0
M98 P3 0002
G00 Z5
M5 M30
O0002
G81 X10 Y10 Z-10 R1 F100
G90 G00 Z0
G91 G00 X0 Y10
M99

N1 F200 S1200 T01 M03
G00 X10 Y10 Z0
M98 P6 0002
M5
G00 Z50
M30

O0002
G91 G00 X0 Y10
G81 Z-10 R1 F100
M99

N1 F200 S1200 T01 M03
G00 X10 Y10 Z0
M98 P6 0002
M5
G00 Z50
M30
O0002
G91 G00 X10 Y0
G81 Z-10 R1 F100
M99

N1 F200 S1200 T01 M03
G00 X10 Y10 Z0
M98 P6 0002
G00 Z5
G90 G00 X10 Y10 Z0
M98 P6 0003
M5
G00 Z50
M30
O0002
G91 G00 X0 Y10
G81 Z-10 R1 F100
M99
O0003
G91 G00 X10 Y0
G81 Z-10 R1 F100
M99

N1 F200 S1200 T01 M03
G00 X10 Y10 Z0
M98 P6 0002
G00 Z5

G90
M98
G00
G91
M98
G00
G91
M98
M5
G00
M30

G00 X10 Y10 Z0
P6 0003
Z5
G00 X0 Y0
P6 0004
Z5
G00 X0 Y0
P6 0005
Z50

O0002
G91 G00 X0 Y10
G81 Z-10 R1 F100
O0003
G91 G00 X10 Y0
G81 Z-10 R1 F100
O0004
G91 G00 X0 Y10
G81 Z-10 R1 F100
O0005
G91 G00 X-10 Y0
G81 Z-10 R1 F100
M99

MILLING PROGRAMS with Subroutines
1. Write a CNC Milling program for a FANUC controlled machine for the given
component using subroutines. Take the depth of cut 1mm, speed 1200rpm. Profile
milling depth = 4mm. Assume suitable feed.
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G94 G90
F100 S1200 T1 M06
G00 X10 Y10 Z0
M98 P3 4000
G01 Z10
M05 M30
4000
G91
G01 Z-1
G01 X50 Y0
G03 X15 Y15 R15
G01 X0 Y50
G01 X-55 Y0
G01 X-10 Y-10
G01 X0 Y-55
M99
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2. Write a CNC Milling program for a FANUC controlled machine for the given
component using subroutines. Profile milling depth = 5mm. Take the depth of cut
0.5mm, speed 1200rpm. Assume suitable feed.
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G90
F100 S1200 T1 M06
G00 X10 Y10 Z2
G00 X10 Y10 Z0
M98 P10 8000
G01 Z10
M05 M30
O8000
G91
G01 Z-0.5
G01 X15 Y0
G02 X15 Y0 R7.5
G01 X10 Y0
G01 X10 Y10
G01 X0 Y20
G01 X-10 Y5
G01 X-15 Y0
G02 X-10 Y0 R5
G01 X-15 Y0
G01 X0 Y-10
G01 X5 Y-10
G01 X-5 Y-10
G01 X0 Y-5
M99
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3. Write a CNC Milling program for a FANUC controlled machine for the given
component using subroutines. Profile milling depth = 5mm. Take the depth of cut
0.5mm, speed 1200rpm. Assume suitable feed.
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N0 G90 F200 S1200 T1 M06
N10 G00 X10 Y10 Z02
N20 G01 Z-5
N40 G01 X10 Y40
N50 G01 X30 Y40
N60 G01 X30 Y65
N70 G01 X10 Y65
N80 G01 X10 Y95
N90 G01 X40 Y95
N100 G01 X40 Y75
N110 G01 X65 Y75
N120 G01 X65 Y95
N130 G01 X95 Y95
N140 G01 X95 Y65
N150 G01 X75 Y65
N160 G01 X75 Y40
N170 G01 X95 Y40
N180 G01 X95 Y10
N190 G01 X65 Y10
N200 G01 X65 Y30
N210 G01 X40 Y30
N220 G01 X40 Y10
N230 G01 X10 Y10
N240 G00 Z2
N250 M05 M30
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Using Subroutine:
N0 G90 F200 S1200 T1 M06
N10 G00 X10 Y10 Z0
N50 M98 P108100
N60 G01 Z10
N70 M05 M30
:8100;
N10 G91
N20 G01 Z-0.5
N40 G01 X0 Y30
N50 G01 X20 Y0
N60 G01 X0 Y25
N70 G01 X-20 Y0
N80 G01 X0 Y30
N90 G01 X30 Y0
N100 G01 X0 Y-20
N110 G01 X25 Y0
N120 G01 X0 Y20
N130 G01 X30 Y0
N140 G01 X0 Y-30
N150 G01 X-20 Y0
N160 G01 X0 Y-25
N170 G01 X20 Y0
N180 G01 X0 Y-30
N190 G01 X-30 Y0
N200 G01 X0 Y20
N210 G01 X-25 Y0
N220 G01 X0 Y-20
N230 G01 X-30 Y0
N240 M99

4. Write a CNC Milling program for a FANUC controlled machine for the given
component using subroutines. Profile milling depth = 6mm. Take the depth of cut
0.5mm, speed 1200rpm. Assume suitable feed.
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N0 G90 F200 S1200 T1 M06
N10 G00 X30 Y30 Z0
N50 M98 P109100
N60 G01 Z10
N70 M05 M30
:9100;
N10 G91
N20 G01 Z-0.5
N30 G01 X0 Y25
N40 G02 X0 Y30 R15
N50 G01 X0 Y20
N60 G01 X20 Y20
N70 G01 X50 Y0
N80 G02 X25 Y-25 R25
N90 G01 X0 Y-60
N100 G01 X-15 Y-10
N110 G01 X-15 Y0
N120 G02 X-40 Y0 R20
N130 G01 X-25 Y0
N140 M99
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5. Write a CNC Milling program for a FANUC controlled machine for the given
component using subroutines. Take the depth of cut 1mm, speed 1200rpm. Assume
suitable feed. Profile milling depth = 4mm. Circular pocket milling – 8mm deep
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10
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N10 G90
N20 F100 S1200 T1 M06
N30 G00 X20 Y10 Z2
N40 G01 Z0
N50 M98 P59000
N60 G01 Z10
N70 G01 G90 Z0
N80 G01 X40 Y40
N90 G66 P9016
X40 Y40 I15 Q0 Z-8 R1 K-5 F100
G67
N100 X0 Y0 Z10
N110 M05 M30
:9000;
N10 G91
N20 G01 X0 Y0 Z-1
N30 G01 X40 Y0
N40 G03 X10 Y10 R10
N50 G01 X0 Y40
N60 G01 X-10 Y10
N70 G01 X-40 Y0
N80 G01 X-10 Y-10
N90 G01 X0 Y-40
N100 G03 X10 Y-10 R10
N110 M99
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1. Write a CNC Milling program for a FANUC controlled machine for the given
component. Profile milling depth = 5mm. speed 1200rpm. Assume suitable feed.
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2. Write a CNC Milling program for a FANUC controlled machine for the given
component. Profile milling depth = 6mm. Take the depth of cut 0.5mm, speed 1200rpm.
Assume suitable feed.
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3. Write a CNC Milling program for a FANUC controlled machine for the given component
using subroutines. Take the depth of cut 1mm, speed 1200rpm. Assume suitable feed.
Profile milling depth = 4mm. Circular pocket milling – 8mm deep. Rectangular pocket
milling – 5mm deep
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Write a CNC Milling program for a FANUC controlled machine for the given component
using subroutines. Take the depth of cut 1mm, speed 1200rpm. Assume suitable feed.
Profile milling depth = 4mm. Circular pocket milling – 8mm deep. Rectangular pocket
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4.

milling – 5mm deep

0
O 4

100

PROCEDURE TO GENERATE G & M CODES FOR TURNING USING
MASTER CAM SOFTWARE
Full profile :
1. Create the drawing in Solid Edge software to the given dimensions.
2. Switch on the Grid and Move the drawing to the origin (0, 0).
3. Save the drawing as .DXF (Drawing Exchange Format) file on the desktop and
exit.
4. Load Master CAM software.
5. File > converters > DXF > Read File > desktop > filename >open > OK > Screen
fit
6. Main Menu > Tool paths > canned rough > chain > options > full > OK
7. Mode >chain > select contour > done
8. Select tool from menu > canned rough parameters > compensation in computer
> off > compensation in control > off > roll cutter around corners > none > ok
9. Menu > tool paths > operations > verify > configure > pick stock corners > pick
corner > ok > machine> post > save NC file > Edit > OK > desktop > save.
10. Program file editor > edit > select all > copy
11. Load EXSL-WIN software > file > new > edit > insert > save
12. Run the program using Full sequence option.

Partial profile:
1. Repeat Step 1 to 5
2. Main Menu > Tool paths > canned rough > chain > options > partial > OK
3. Mode >chain > select contour (partial) > done
4. Select tool from menu > canned rough parameters > compensation in computer > off
> compensation in control > off > roll cutter around corners > none > ok
5. Repeat step 2,3 &4 for remaining contour
6. Menu > tool paths > operations > verify > configure > pick stock corners > pick
corner > ok > select all > ok > machine> post > save NC file > Edit > OK > desktop
> save.
7. Program file editor > edit > select all > copy
8. Load EXSL-WIN software > file > new > edit > insert > save
9. Run the program using Full sequence option
Grooving:
1. Repeat Step 1 to 5
2. Main Menu > Tool paths > canned groove >groove definition >2 points > select first
point (select top corner of the groove) > select second point (select opposite
bottom corner of the groove) > backup > select the grooving tool > OK > done
Thread Cutting:
1. Repeat Step 1 to 5
2. Main Menu > Tool paths > thread> select the threading tool > Thread shape
parameter > lead > mm/thread > enter the pitch > included angle > (60 for v thread)
> major diameter > select the profile > start position > (select the left hand end of the
thread for LH thread and right hand end of the thread for RH thread) > end position
(select the other end of the thread) >compute from formula > select the thread form
> ok
3. Thread cut parameter > NC code format > canned G76 > OK

PROCEDURE TO GENERATE G & M CODES FOR MILLING USING
MASTER CAM SOFTWARE
POCKET MILLING:
1. Create the drawing in Solid Edge software to the given dimensions.
2. Switch on the Grid and Move the drawing to the origin (0, 0).
3. Save the drawing as .DXF (Drawing Exchange Format) file on the desktop and
exit.
4. Load Master CAM software.
5. File > converters > DXF > Read File > desktop > filename >open > OK > Screen
fit
6. Main Menu > Tool paths > pocket > chain > options > full > OK
7. Mode >chain > select profiles (pockets) > done
8. Pocket (Standard) > Tool parameters> Tool Dia > 6mm (select suitable diameter)
9. Pocket parameters > Depth of pocket > -10mm (Enter depth of pocket)
10. Roughing/finishing parameters > Switch off entry helix > ok
11. Menu > tool paths > operations > verify > configure > pick stock corners > pick
corner > enter z value (thickness of the stock) > -20 > ok> machine> close >
post > save NC file > Edit > OK > desktop > save.

CONTOUR MILLING:
1. Repeat Step 1 to 5
2. Main Menu > Tool paths > contour > chain > options > full > OK
3. Mode >chain > select contour (select the profile) > done
4. Contour (2D) > Tool parameters > Tool Dia > 6mm(select suitable diameter)
5. Contour (2D) > contour parameters > Depth of contour > -10mm (Enter contour
depth) > compensation computer > off >compensation in control > off > OK
6. Menu > tool paths > operations > verify > configure > pick stock corners > pick
corner > enter z value (thickness of the stock) > -20 > ok> machine> close >
post > save NC file > Edit > OK > desktop > save.

ISLAND MILLING:
1. Repeat Step 1 to 5
2. Main Menu > Tool paths > Pocket > chain > options > full > OK
3. Mode >chain > select contour (select both inside and outside profiles) > done
4. Pocket (Standard) > Tool parameters> Tool Dia > 6mm (select suitable diameter)
5. Pocket parameters > Depth of pocket > -10mm (Enter depth)
6. Roughing/finishing parameters > Switch off entry helix > ok

7. Menu > tool paths > operations > verify > configure > pick stock corners > pick
corner > enter z value (thickness of the stock) > -20 > ok> machine> close >
post > save NC file > Edit > OK > desktop > save.
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2. Generate G&M codes for the component shown in figure using Cam software.
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TURNING PROFILES
1. Generate G&M codes for the component shown in figure using Cam software.
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3. Generate G&M codes for the component shown in figure using Cam software.
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4. Generate G&M codes for the component shown in figure using Cam software.
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Pitch = 2mm
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5. Generate G&M codes for the component shown in figure using Cam software.
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MILLING PROFILES
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1. Generate G & M codes for the component shown in figure using CAM Software
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2. Generate G & M codes for the component shown in figure using CAM Software
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3. Generate G & M codes for the component shown in figure using CAM Software
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4. Generate G & M codes for the component shown in figure using CAM Software
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5. Generate G & M codes for the component shown in figure using CAM Software
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6. Generate G & M codes for the component shown in figure using CAM Software
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Generate G & M codes for the component shown in figure using CAM Software

Pocket depth - 20mm
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Rectangular Pocket depth - 45mm
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8.

Generate G & M codes for the component shown in figure using CAM Software
Drilling
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Contour Depth : 15mm
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Hexagonal Pocket Depth : 15mm
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Generate G & M codes for the component shown in figure using CAM Software
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10.Generate G & M codes for the component shown in figure using CAM Software
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11.Generate G & M codes for the component shown in figure using CAM Software
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Contour Depth : 10mm

Commonly Used G-codes for Turning Centers
Standard G code
G00
G01
G02
G03
G04
G07
G09
G10
G20
G21
G22
G23
G27
G28
G29
G30
G31
G32
G34
G36
G37
G40
G41
G42
G50

Special G Code
G00
G01
G02
G03
G04
G07
G09
G10
G20
G21
G22
G23
G27
G28
G29
G30
G31
G32
G34
G36
G37
G40
G41
G42
G92

Special G Code C
G00
G01
G02
G03
G04
G07
G09
G10
G20
G21
G22
G23
G27
G28
G29
G30
G31
G32
G34
G36
G37
G40
G41
G42
G92

G65
G66
G67
G68
G69
G70
G71
G72
G73
G74
G75
G76
G90
G92
G94
G96
G97
G98
G99
-------

G65
G66
G67
G68
G69
G70
G71
G72
G73
G74
G75
G76
G77
G78
G79
G96
G97
G94
G95
G90
G91

G65
G66
G67
G68
G69
G72
G73
G74
G75
G76
G77
G78
G20
G21
G24
G96
G97
G94
G95
G90
G91

Function
Rapid Traverse
Linear Interpolation
Circular Interpolation CW
Circular Interpolation CCW
Dwell
Hypothetical Axis Interpolation (sine wave)
Exact Stop
Parameter Setting
Inch Data Input
Metric Data Input
Stored Stroke Limit On
Stored Stroke Limit Off
Reference Point Return Check
Reference Point Return
Return from Reference Point
Return to second, third and fourth Reference Point
Skip Signal
Thread Cutting
Variable Lead Thread Cutting
Automatic Tool Compensation X Axis
Automatic Tool Compensation Z Axis
Tool Nose Radius Compensation Cancel
Tool Nose Radius Compensation Left
Tool Nose Radius Compensation Right
Absolute Zero Point/Maximum Spindle Speed
Setting
User Macro Simple Call
User Macro Modal Call
User Macro Modal Call Cancel
Mirror Image for double Turrets ON
Mirror Image for double Turrets Off
Finishing Cycle
Stock Removal in Turning
Stock Removal in Facing
Pattern Repeating
Peck drilling in Z Axis
Grooving in X Axis
Thread Cutting Cycle
Cutting Cycle A (Turning)
Thread Cutting cycle
Cutting Cycle B (Facing)
Constant Surface Speed Control On
Constant Surface Speed Control Off
Feed per Minute
Feed per Revolution
Absolute Programming
Incremental Programming

Commonly Used G Codes for Machining Centers
G00
G01
G02
G03
G04
G07
G09
G10
G17
G18
G19
G20
G21
G22
G23
G27
G28
G29
G30
G31
G33
G40
G41
G42
G43
G44
G49
G45
G46
G47
G48
G50
G51
G52

Rapid Traverse
Linear Interpolation
Circular Interpolation CW
Circular Interpolation CCW
Dwell
Imaginary Axis Interpolation
Exact Stop
Parameter Setting
XY Plane Selection
XZ Plane Selection
YZ Plane Selection
Inch Input
Metric Input
Stored Stroke Limit On
Stored Stroke Limit Off
Reference Point Return Check
Reference Point Return
Return from Reference Point
Return to 2nd, 3rd & 4th Ref. Point
Skip Signal
Thread Cutting
Cutter Compensation Cancel
Cutter Compensation Left
Cutter Compensation Right
Tool Length Compensation +
Tool Length Compensation Tool Length Comp. Cancel
Tool Offset Increase
Tool Offset Decrease
Tool Offset Double Increase
Tool Offset Double Decrease
Scaling Off
Scaling On
Local Coordinate System Setting

M00
M01
M02
M03
M04
M05
M06
M07
M08
M09
M19
M20

Program Stop
Optional Stop
Program End (No Rewind)
Spindle CW
Spindle CCW
Spindle Stop
Tool Change
Mist Coolant On
Flood Coolant On
Coolant Off
Spindle Orient On
Spindle Orient Off

G54
G55
G56
G57
G58
G59
G60
G61
G64
G65
G66
G67
G68
G69
G73
G74
G76
G80
G81
G82
G83
G84
G85,G86
G87
G88,G89
G90
G91
G92
G94
G95
G96
G97
G98
G99
Standard M Codes
M21
M22
M23
M24
M25
M26
M27
M28
M30
M98
M99
M19-M28

Work Coordinate System 1
Work Coordinate System 2
Work Coordinate System 3
Work Coordinate System 4
Work Coordinate System 5
Work Coordinate System 6
Single Direction Positioning
Exact Stop Check Mode
Cutting Mode
User Macro Simple Call
User Macro Modal Call
User Macro Modal Call Cancel
Coordinate System Rotation
Coordinate System Rotation Cancel
Peck Drilling Cycle
Left Hand Tapping Cycle
Fine Boring
Canned Cycle cancel
Drilling Cycle
Counter Boring Cycle
Peck Drilling with Full Retract
Tapping Cycle
Boring Cycle
Back Boring Cycle
Boring Cycle
Absolute Programming
Incremental Programming
Set Absolute Zero Point
Feed per Minute
Feed per Revolution
Constant Surface Speed On
Constant Surface Speed Off
Return to Initial Point in Canned Cycle
Return to R point in Canned Cycle
Tool Magazine Right
Tool Magazine Left
Tool Magazine Up
Tool Magazine Down
Tool Clamp
Tool Unclamp
Clutch Neutral On
Clutch Neutral Off
Program End (Rewind)
Call Sub-Program
End of Sub-Program
Used for Maintenance Purposes

